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Welcome From The Chief Editor
 
 



I remember in my column last month that I said that Meemaw would likely be writing the Welcome From The Chief Editor column. But, that was before we knew that my then unborn son had different plans. With an original due date of August 29, Ryan Charles Arnote was born August 6, 2013, at 3:36 p.m, weighing 6 pounds, 4 ounces (2820 grams) and 19" (48.3 cm) long. He caught us rather off guard. No, no, no. Not like that -- we knew he was coming. We just thought we had at least three more weeks to put the finishing touches on the nursery and other last minute "things."

 

 


Ryan and Dad, just minutes after his birth.
 



So, with Ryan making his entrance at the first part of the month, it has somewhat freed me up at the end of the month -- when he was supposed to arrive -- to maintain my "regular duties" as the magazine's Chief Editor. I'm sure that Meemaw doesn't mind too much either, since her schedule was already rather full overseeing and organizing the county meeting for the company she works for.




So am I a proud papa? Do fish swim? After wanting children for most of my life, and after suffering through seven years of infertility (my wife's fallopian tubes were blocked), all the dirty, poopy diapers, late night feedings, and fussy cries (of which there really haven't been many) are like the most perfectly constructed, most beautiful symphony in the world, to me and my wife.




August also saw PCLinuxOS Full Monty receive a quarterly update, to join with the July updates of the KDE and LXDE Live CDs, and the new release of the Mate Live CD mid July. That bring the total number of Live CDs for PCLinuxOS to eight -- each of the Live CDs available as 32 bit or 64 bit versions.




This month we have quite a wide variety of articles, ranging from security issues (passwords and using a VPN), to more LibreOffice tips and tricks, to free stuff (like free VirtualBox images from that "evil empire" in Redmond and free daily HD wallpapers from National Geographic). September is also considered "back to school" month, even though some kids returned to school in mid to late August.




Don't forget that we are always looking for article submissions and ideas for The PCLinuxOS Magazine. If you have a special use for PCLinuxOS, or perhaps a unique computing setup or need, we'd love to hear about it. If you just have an idea for an article, pitch it and we'll do what we can to see about getting written up (provided anyone around here has the knowledge to write it up). Even better, write it up yourself and send it to us. Don't worry if English isn't your first language, or that you might not consider yourself much of a writer. We'll work with you to put the final spit and polish on that article (after all, that's part of what editors do). But you have to submit it to us, first.




We'll accept articles in whatever format you want to submit them to us. While Google Docs is the preferred article submission avenue, we'll also accept them as LibreOffice files, AbiWord files, text files with separate images rolled into a *.tar.gz file. Heck, we'll even take them written on the back of a napkin, if you can figure out a way to get the napkin(s) to us. If you want more information, don't hesitate to send either Meemaw or me a private message in the PCLinuxOS forum. You can also send your ideas and/or articles to pclinuxos.mag@gmail.com. They will come straight to my inbox.




This month's magazine cover image celebrates the return to school, and highlights a guest article from Dwight Dover, on the KDE blog site. He gives a report about a girls' school in England that switched all of their computers to Linux one year ago, and how that migration has gone.




Until next month, I bid you all peace, happiness, prosperity and serenity.
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Get A New HD NatGeo Wallpaper Image Every Day
 
 



by Paul Arnote (parnote)




Back in July, agmg made a post in the PCLinuxOS forum seeking sites to download new wallpaper images. As usual, the PCLinuxOS community responded with numerous suggestions of sites from which to download wallpaper images. The PCLinuxOS Magazine even ran an article listing some popular wallpaper sites in the past.




Then, I came across this custom script that downloads the National Geographic Picture Of The Day. If you're unfamiliar with these images, follow the previous link and have a look. The original script is here. A modified version of the same script is here. Below is a version of the script that I've further modified. True to the reputation of National Geographic, the images are stunning and of very high quality.

 


 



The original version of the script automatically sets the newly downloaded image as your wallpaper -- provided that you are running the GNOME desktop. However, each different desktop environment has a unique method for setting the desktop wallpaper from the command line. One thing that is quite problematic is determining which desktop environment is currently running, via the command line. I've yet been able to find a test that reliably returns the currently running desktop from the command line or a bash file.




Here is the script, with my modifications (which I'll explain below). You can copy and paste it into your favorite plain text editor (no, LibreOffice does not qualify). You can also download a copy from The PCLinuxOS Magazine website. If you download a copy of the script, be sure to remove the .txt file extension. In either case, be sure to save it to a location that is in your system's path, and be sure to set the file to be executable (e.g., chmod +x ~/path/to/script/NatGeo-POD.sh).





#!/bin/bash  
 # Copyright (c) 2011 Josh Schreuder  
 # http://www.postteenageliving.com  
 #  
 # Permission is hereby granted, free of charge, to any person obtaining a copy  
 # of this software and associated documentation files (the "Software"), to deal  
 # in the Software without restriction, including without limitation the rights  
 # to use, copy, modify, merge, publish, distribute, sublicense, and/or sell  
 # copies of the Software, and to permit persons to whom the Software is  
 # furnished to do so, subject to the following conditions:  
 #  
 # The above copyright notice and this permission notice shall be included in  
 # all copies or substantial portions of the Software.  
 #  
 # THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR  
 # IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,  
 # FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE  
 # AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER  
 # LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,  
 # OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN  
 # THE SOFTWARE.  
 # ********************************  
 # *** OPTIONS  
 # ********************************  
 # Set this to 'yes' to save a description (to ~/description.txt) from ngeo page  
 #
 # I can't see where this line is used anywhere in the script, so let's comment it out
 # GET_DESCRIPTION="yes"  
 #
 # Set this to the directory you want pictures saved  
 PICTURES_DIR=~/Wallpaper/NatGeo
 if [ ! -d $PICTURES_DIR ]; then
   mkdir -p $PICTURES_DIR
 fi
 sleep 1
 # ********************************  
 # *** FUNCTIONS  
 # ********************************  
 function get_page {  
   echo "Downloading page to find image"  
   wget http://photography.nationalgeographic.com/photography/photo-of-the-day/ --quiet -O- 2> /dev/null |  
   grep -m 1 http://images.nationalgeographic.com/.*.jpg -o > /tmp/pic_url
   wget http://photography.nationalgeographic.com/photography/photo-of-the-day/ --quiet -O- 2> /dev/null |  
   grep -m 1 http://images.nationalgeographic.com/.*1600x1200.*.jpg -o > /tmp/pic_url2
 }  
 function clean_up {  
   # Clean up  
   echo "Cleaning up temporary files"  
   if [ -e "/tmp/pic_url" ]; then  
     rm /tmp/pic_url  
   fi  
   if [ -e "/tmp/pic_url2" ]; then  
     rm /tmp/pic_url2
   fi
   if [ -f "~/tmp/NatGeo.edc" ]; then
     rm -f ~/tmp/NatGeo.edc
   fi
}
  function make_js {
    js=$(mktemp)
    cat > $js <<_EOF
      var wallpaper = "$PICTURES_DIR/${TODAY}_ngeo.jpg";
      var activity = activities()[0];
      activity.currentConfigGroup = new Array("Wallpaper", "image");
      activity.writeConfig("wallpaper", wallpaper);
      activity.writeConfig("userswallpaper", wallpaper);
      activity.reloadConfig();
_EOF
}
 function kde_wallpaper {
   make_js
   qdbus org.kde.plasma-desktop /MainApplication loadScriptInInteractiveConsole $js > /dev/null
   # sleep 2
   # You will need to install xdotool from Synaptic
   xdotool search --name "Desktop Shell Scripting Console -- Plasma Desktop Shell" windowactivate key ctrl+e key ctrl+w
   rm -f "$js"
   dbus-send --dest=org.kde.plasma-desktop /MainApplication org.kde.plasma-desktop.reparseConfiguration
   dbus-send --dest=org.freedesktop.DBus /org/freedesktop/DBus org.freedesktop.DBus.ReloadConfig
   dbus-send --dest=org.kde.kwin /KWin org.kde.KWin.reloadConfig
   # kbuildsycoca4 2>/dev/null && kquitapp plasma-desktop 2>/dev/null ; kstart plasma-desktop > /dev/null 2>&1
 }
 function xfce_wallpaper {
   xfconf-query -c xfce4-desktop -p /backdrop/screen0/monitor0/image-path -s $PICTURES_DIR/${TODAY}_ngeo.jpg
 }
 function lxde_wallpaper {
   pcmanfm -w "$PICTURES_DIR/${TODAY}_ngeo.jpg"
 }
 function mate_wallpaper {
   gsettings set org.mate.background picture-filename $PICTURES_DIR/${TODAY}_ngeo.jpg
 }
 function e17_wallpaper {
   OUTPUT_DIR=~/.e/e/backgrounds
   FileName=$PICTURES_DIR/${TODAY}_ngeo.jpg
   edcFile=~/tmp/NatGeo.edc

   echo 'images { image: "'$FileName'" LOSSY 90; }' > $edcFile
   echo 'collections {' >> $edcFile
   echo 'group { name: "e/desktop/background";' >> $edcFile
   echo 'data { item: "style" "4"; }' >> $edcFile
   echo 'data.item: "noanimation" "1";' >> $edcFile
   echo 'max: 990 742;' >> $edcFile
   echo 'parts {' >> $edcFile
   echo 'part { name: "bg"; mouse_events: 0;' >> $edcFile
   echo 'description { state: "default" 0.0;' >> $edcFile
   echo 'aspect: 1.334231806 1.334231806; aspect_preference: NONE;' >> $edcFile
   echo 'image { normal: "'$FileName'";  scale_hint: STATIC; }' >> $edcFile
   echo '} } } } }' >> $edcFile
   edje_cc -nothreads ~/tmp/NatGeo.edc -o $OUTPUT_DIR/NatGeo.edj
   sleep 2 && rm -f ~/tmp/NatGeo.edc
   echo 'Enlightenment e17 NatGeo.edj file created'
   enlightenment_remote -desktop-bg-del 0 0 -1 -1
   enlightenment_remote -desktop-bg-add 0 0 -1 -1 $OUTPUT_DIR/NatGeo.edj;
 }
 function usage {
   printf "%s\n%s\n\n%s\n%s\n\n%s\n\n%s" \
   "NatGeo-POD will download the National Geographic Picture Of The Day,"\
   "and (optionally) set that picture as the new wallpaper."\
   "Written and drawn from several sources by Paul Arnote for PCLinuxOS."\
   "Originally published in The PCLinuxOS Magazine (http://pclosmag.com), Sept. 2013 issue."\
   "Works for KDE4, Xfce, LXDE, Mate and e17 desktops."\
   "Usage: $0 [arguments]"\

   printf "\n %s\t%s" \
   "-h, --help" "This help text"
   printf "\n %s\t\t%s" \
   "-d" "Download pictures ONLY"
   printf "\n %s\t\tSetup for the %s" \
   "--xfce"    "XFCE4 Desktop"\
   "--mate"    "Mate Desktop"\
   "--lxde"    "LXDE Desktop"\
   "--kde4"    "KDE4 Desktop"\
   "--e17"    "Enlightenment Desktop"
   printf "\n"
 }
 # ********************************  
 # *** MAIN  
 # ********************************  
 if [ "$1" == "--help" ] || [ "$1" == "-h" ] || [ "$1" == "" ]; then
   usage
   exit
 fi
 echo "===================="  
 echo "== NGEO Wallpaper =="  
 echo "===================="  
 # Set date  
 TODAY=$(date +'%Y%m%d')  
 # If we don't have the image already today  
 if [ ! -e $PICTURES_DIR/${TODAY}_ngeo.jpg ]; then  
   echo "We don't have the picture saved, save it"  
   get_page  
   # Got the link to the image  
   PICURL=`/bin/cat /tmp/pic_url`
   PICURL2=`/bin/cat /tmp/pic_url2`
   echo "Picture URL is: ${PICURL}"
   echo "Picture URL 2 is: ${PICURL2}"  
   echo "Downloading images"
   wget --quiet $PICURL -O $PICTURES_DIR/${TODAY}_ngeo.jpg
   wget --quiet $PICURL2 -O $PICTURES_DIR/${TODAY}-1600x1200_ngeo.jpg
   if [ "$1" != "-d" ]; then
     echo "Setting image as wallpaper"
   fi
   # Uncomment (remove the #) in front of the appropriate command for your particular desktop environment
   # For Xfce
   if [ "$1" == "--xfce" ]; then
     xfce_wallpaper
   fi
   # For LXDE
   if [ "$1" == "--lxde" ]; then
     lxde_wallpaper
   fi
   # For Mate
   if [ "$1" == "--mate" ]; then
     mate_wallpaper
   fi
   # For KDE4
   if [ "$1" == "--kde4" ]; then
     kde_wallpaper
   fi
   # For e17
   if [ "$1" == "--e17" ]; then
     e17_wallpaper
   fi
   #
 # Else if we have it already, check if it's the most updated copy  
 else  
   get_page  
   # Got the link to the image  
   PICURL=`/bin/cat /tmp/pic_url`
   PICURL2=`/bin/cat /tmp/pic_url2`
   echo "Picture URL is: ${PICURL}"
   echo "Picture URL 2 is: ${PICURL2}"
   # Get the filesize  
   SITEFILESIZE=$(wget --spider $PICURL 2>&1 | grep Length | awk '{print $2}')  
   FILEFILESIZE=$(stat -c %s $PICTURES_DIR/${TODAY}_ngeo.jpg)  
   # If the picture has been updated  
   if [ $SITEFILESIZE != $FILEFILESIZE ]; then  
     echo "The pictures have been updated ... getting updated copy"  
     rm $PICTURES_DIR/${TODAY}_ngeo.jpg
     rm $PICTURES_DIR/${TODAY}-1600x1200_ngeo.jpg
     # Got the link to the image  
     PICURL=`/bin/cat /tmp/pic_url`
     PICURL2=`/bin/cat /tmp/pic_url2`
     echo "Downloading images"
     wget --quiet $PICURL -O $PICTURES_DIR/${TODAY}_ngeo.jpg
     wget --quiet $PICURL2 -O $PICTURES_DIR/${TODAY}-1600x1200_ngeo.jpg      
   if [ "$1" != "-d" ]; then
     echo "Setting image as wallpaper"
   fi
   # Uncomment (remove the #) in front of the appropriate command for your particular desktop environment
   # For Xfce
   if [ "$1" == "--xfce" ]; then
     xfce_wallpaper
   fi
   # For LXDE
   if [ "$1" == "--lxde" ]; then
     lxde_wallpaper
   fi
   # For Mate
   if [ "$1" == "--mate" ]; then
     mate_wallpaper
   fi
   # For KDE4
   if [ "$1" == "--kde4" ]; then
     kde_wallpaper
   fi
   # For e17
   if [ "$1" == "--e17" ]; then
     e17_wallpaper
   fi
   #
   # If the picture is the same  
   else  
     echo "Picture is the same, finishing up"  
   if [ "$1" != "-d" ]; then
     echo "Setting image as wallpaper"
   fi
   # For Xfce
   if [ "$1" == "--xfce" ]; then
     xfce_wallpaper
   fi
   # For LXDE
   if [ "$1" == "--lxde" ]; then
     lxde_wallpaper
   fi
   if [ "$1" == "--mate" ]; then
     mate_wallpaper
   fi
   # For KDE4
   if [ "$1" == "--kde4" ]; then
     kde_wallpaper
   fi
   # For e17
   if [ "$1" == "--e17" ]; then
     e17_wallpaper
   fi
   #
   fi  
 fi  
 clean_up

 



Modifications




My modifications include testing to see if the specified directory to store the images in exists or not. If not, the directory is created. For my personal use, I tend to keep all of my wallpaper images in their own separate directory in my /home directory, called Wallpaper (if you can imagine that). Because this directory will have a tendency to fill up rather quickly, I've set the script to save all of the images it downloads to the ~/Wallpaper/NatGeo directory. In the script above, the directory will be created if it doesn't already exist. You can change it to whatever location best suits your habits and needs.




I also commented out the GET_DESCRIPTION variable definition. I can't see where this is used anywhere in the script, so I don't see any reason to have an extra variable defined that isn't used.




There are two different sizes of the image available. One is the default size displayed on the website, while the other one is a 1600 x 1200 pixel sized version. I've modified the script to download both image sizes.




Had I been able to find a reliable way to determine the currently running desktop, it would be a relatively simple task to add a conditional test (or tests) to issue the correct command to set the desktop wallpaper for that particular desktop environment. As it is now, the script contains the commands to set the desktop wallpaper for the Xfce, LXDE, e17, Gnome and KDE4 desktop environments. Instead of detecting which desktop is currently running, you will specify the currently running desktop as a command switch when launching the script (see the "Usage" section of the article, below). The command switch tells the script exactly how to manipulate the graphics used for the desktop wallpaper.




Also, in the commands I used in the script to automatically change the desktop wallpaper, I've defaulted to using the smaller, lower resolution images. If you prefer to use the larger, higher resolution images, simply add -1600x1200 between the ${TODAY} and _ngeo.jpg part of the filename. Just keep in mind that there is not always a 1600x1200 image available every day. Using the 1600x1200 image as your automatic wallpaper may result in no background wallpaper image at all being displayed on the days that a 1600x1200 image is not available. As an added bonus, the smaller, lower resolution image is free of the National Geographic watermark branding, while the 1600x1200 image always displays the watermark.

 



Notes About The Desktops




I have tested this script in all five of the "major" desktop environments available under PCLinuxOS. I've tested it on bare metal installations of Xfce and KDE4, and in VirtualBox installations of LXDE, Mate and e17. It has worked flawlessly for me on all five desktop environments.




The hardest desktop environment to get to displaying the wallpaper was e17. Because e17 uses a very unique approach to displaying wallpaper, it wasn't a simple matter of just displaying a JPG or PNG file, as you do with most other desktop environments. After downloading the image(s), you then have to create a special template file (*.edc), and then compile that template file into a special *.edj file, and then set that file as the desktop wallpaper. Important Notice to e17 users: make sure that the DBus Extensions module (Settings > Module > System) is loaded, or otherwise, the script will not work to change the wallpaper.




I tip my hat to the KDE4 developers. They have succeeded in making it ridiculously and exceptionally difficult to change the KDE4 wallpaper from the command line. So much for simplicity. With KDE4, you have to create a Javascript script on the fly to write out the values for the KDE4 desktop wallpaper, and then clumsily execute that script. The process isn't pretty, but it does work. To pull this off for KDE4, you will need to install xdotool from Synaptic.




If you are running KDE on a computer with limited resources or a slower CPU, you may need to uncomment the sleep 2 command in the kde_wallpaper function to create a two second pause. The script runs fine without it on my Intel Duo-Core 2.2 GHz laptop that runs KDE4.





You will also notice that I've purposely left the line that starts with kbuildsycoca4 commented out. Under older versions of KDE4, this line appeared to be necessary. However, under my fully updated KDE 4.10, I've not found this line to be necessary. This line stops, then restarts, the KDE4 Plasma Desktop, in order to send the message to redraw the wallpaper. If you find that you are having difficulty getting the wallpapers to redraw on the screen, you might try uncommenting this line. I doubt, though, that you will need it. To say the least, this is a very clumsy and kludgy workaround to something that should be simple.




The Mate, LXDE and Xfce desktop environments were the "easy" ones to set the wallpaper from a command line or bash script. The developers of these three desktop environments had the foresight to include relatively easy, straightforward methods to manipulate the desktop wallpaper from a text-based interface, such as the command line or a bash script.

 



Usage




Like most command line utilities, the NatGeo-POD script has some command line options. To start with, entering NatGeo-POD.sh, NatGeo-POD.sh -h or NatGeo-POD.sh --help on the command line will display a brief set of help and usage data.

 


 



If you don't want the script to automatically change your wallpaper, simply use the -d command line switch. The script will still download the NatGeo POTD, but skip trying to set the desktop wallpaper.

 


 



When starting the script, you will do so using a command line switch to specify which desktop environment. The choices are --kde4, --xfce, --lxde, and --mate. In the previous image, you can see the script output when I ran it on one of my Xfce installations.

 


 



If you run the script more than once in a day, it will check to see if you have the most current version of the images. If you do, the script will skip downloading them again, and will set the images as the desktop wallpaper.

 



So ... What Do You Get?




Well, like I mentioned above, you will get two different sizes of the National Geographic Picture Of The Day. Below is an example.

 


 



To make use of this script, you could simply run it every day when you're at your computer. Even better yet, you could set this script to run automatically, via crontab, at the same time, every day. That way, you'll be sure to never miss out on any of the pictures -- provided you leave your computer on all the time (like I do). By running the script by way of a crontab task, you'll have new wallpaper images delivered straight to your computer, daily. Now, how awesome is that?
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Donations: the Lifeblood of PCLinuxOS
 
 



by Paul Arnote (parnote)




Let's label things. Texstar, a.k.a. Bill Reynolds is the founder of PCLinuxOS. The packagers, a.k.a. The Bacon Brigade, are the heartbeat of PCLinuxOS. The PCLinuxOS users are the soul of PCLinuxOS. That would make your donations the life blood of PCLinuxOS.




Without your donations, PCLinuxOS would not be able to exist. Unlike other Linux distributions, there are no large corporations providing support (Mandriva, OpenSUSE and Fedora). There are no millionaires or billionaires funnelling untold amounts of cash to keep things running (Canonical/Ubuntu's Mark Shuttleworth).




PCLinuxOS is the product of one man, our founder. He is not a rich man, at least not in the monetary sense. A generous staff of volunteers offer their services to help with packaging, maintenance of the forum and website, producing this magazine, creating updated ISOs and maintaining the repositories. The largest share of funding for PCLinuxOS comes from the generosity of its users making donations.

 


 



PCLinuxOS also has a couple of other sources of income. One source is revenue from the ads that are displayed on the main PCLinuxOS website. Another source is from the proceeds from the sale of PCLinuxOS items in the Official PCLinuxOS Store, on the CafePress site. PCLinuxOS receives a percentage of the profits from every item sold.

 



How Can I Donate?




There are three ways you can make a donation to PCLinuxOS.




The first way is also the newest way to make a donation. Starting in July 2013, PCLinuxOS users were able to make donations on a recurring monthly basis, via a service called Gumroad. Users can sign up to make a monthly, recurring donation of $1, $5, $10 or $25, charged to a credit or debit card. All funds are in U.S. dollars. So, if you weren't able to afford a higher, once-a-year donation, perhaps you can afford a recurring, monthly donation of a smaller amount.




"It is a simple and inexpensive way to help us cover the cost and maintenance associated with PCLinuxOS," said Texstar. "Not everyone can afford to donate 10, 20 or 50 dollars but they might be able to spare a dollar for their favorite distribution. Gumroad, the provider of this service, comes highly recommended and has very favorable reviews in the press. Many open source projects use this service, such as Frostwire."




The second way to donate, PCLinuxOS users can also make larger, lump sum donations, via Google Checkout. Donation amounts are $10, $25, $50, $100, $250 or $500. You can make a donation once a year, or several times a year, if you like.




The third way to donate to PCLinuxOS is via snail mail, by sending a check or money order (drawn on a U.S. bank). The mailing address is here, towards the bottom of the page.

 



What Are The Funds Used For?




The money donated to PCLinuxOS mostly goes towards paying the bills for the server hosting and maintenance for the PCLinuxOS website and repositories every month. As you might be able to imagine, that is no small expenditure, given the amount of traffic through the PCLinuxOS website every month.




"Advertising revenue is almost dead, since everyone is running ad blocks. This is what we were using to pay Enki's $200.00 per month hosting fee. They now have us being hosted in VMWare. We need to find a new home. Shared hosting is not an option, due to the amount of traffic we get. namecheap.com has a decent VPS server for 29.95 per month, but we need more than 5 people pledging support," said Texstar.

 



Why Should I Donate?




Wouldn't it be a shame if the best Linux distro on the planet, and our favorite, disappeared overnight, simply because no one cared enough to donate the necessary money to keep the web hosting bills paid?




Another way to look at it is like this scenario that follows. Back when you were using closed-source, proprietary operating systems (we all know which one that was, so I don't need to utter their name here), you thought nothing of going out and spending $100 for the latest and greatest version. You thought nothing of going out and spending a bucket-load of cash on an office suite. You had to pay for annual subscriptions to antivirus software that you no longer have to pay for. By the time you add in the costs of all the other incidental programs you used, that "other" operating system would put a serious hurt on your finances.




With all of that in mind, coupled with the quality and quantity you get with PCLinuxOS, making a $25 or $50 donation once a year is a pretty good deal. Or, instead of making those lump sum donations, why not help with a recurring, monthly donation of $1 or $5? Trust me...no donation is too small to help keep our little corner of the Linux universe afloat.

 



Are There Other Ways I Can Help?




Without a doubt, there are a number of other ways you can help, in addition to making a donation to help keep things afloat.




First, you can turn off your ad blocking software when you are on the PCLinuxOS website. If the ads are blocked, and thus not displayed, there are no "click-throughs" of the ads, and there is no revenue generated for PCLinuxOS. Every now and again, it would be helpful to click on one of the ads. Revenue is generated for PCLinuxOS every time an ad is clicked.




Second, the next time you're shopping for a new shirt, a new coffee mug, a new mouse pad, a wall clock, or a sticker for your new laptop, head on over to the Official PCLinuxOS Store. Even better yet, give PCLinuxOS merchandise as gifts. The merchandise in the store is very good quality, and you'll be helping spread the word about the best Linux distro ever -- PCLinuxOS.
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PCLinuxOS Recipe Page
 
 


 
 



Fresh Blackberry Custard Pie
 
 



Ingredients:

1 (9 inch) pie crust




FOR THE BERRIES:

2 cups fresh berries

1 1/2 cups sugar

1/4 cup flour




FOR THE CUSTARD:

2 eggs, beaten

1 small can evaporated milk (2/3 cup)

1/2 tsp. vanilla




FOR THE CRUMB TOPPING:

1/2 cup sugar

1/3 cup flour

1/4 cup margarine

1/2 tsp. vanilla




Cooking Instructions:




Combine berries, 1 1/2 cups sugar and flour and toss to coat fruit. Fill a pastry lined 9 inch pie plate.



Mix beaten eggs, milk and vanilla and pour over fruit.



Mix topping ingredients together until it resembles coarse crumbs. Sprinkle crumb mixture over berry filling.



Bake at 350 degrees F about 1 hour or until done.
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Game Zone: Portal
 
 



by daiashi



 



About The Game




Portal™ is a new single player game from Valve. Set in the mysterious Aperture Science Laboratories, Portal has been called one of the most innovative new games on the horizon and will offer gamers hours of unique gameplay.




The game is designed to change the way players approach, manipulate, and surmise the possibilities in a given environment, similar to how Half-Life® 2's Gravity Gun innovated new ways to leverage an object in any given situation.




Players must solve physical puzzles and challenges by opening portals to maneuver objects, and themselves, through space.

 



My Synopsis




I find the game a pleasant change from all the shoot-em-up and gore titles out there. While there is some turret dodging and some hanging robot computer thing to defeat, it's nice to see a title where real puzzle solving skills are required. Why, you ask, did you do a review on a game this old? That's easy. It plays on PCLinuxOS and it is still a great looking game. My only gripe is it's somewhat short of a story line. Other than that, it is still a highly played game by anyone that is into Valve and Steam. Although Portal2 has been out for a bit, I wanted to start from the beginning and maybe do an article on the second Portal if there is enough difference between the two.

 



System requirements




Software:




PCLinuxOS & Steam by Valve.




Hardware:




OS: PCLinuxOS

Processor: x86-compatible 1.7GHz or faster processor

Memory: 512 MB System RAM

Hard Disk Space: 4GB free space (subject to change)

Video Card:3D graphics card with at least 256MB of addressable memory.

 



About The Company




Valve Corporation 

  http://www.valvesoftware.com/company/people.html




Valve is an American video game development and distribution company. Its home is in Bellevue, Washington. Founded in 1996 by former Microsoft employees Gabe Newell and Mike Harrington, Valve is most noted from its 1998 release of Half-Life and its 2007 release of Portal. After securing a license to the Quake engine in 1996, the team started developing Half-Life. Half-Life was released in late 1998. At the back bone of all of Valves games is their source engine, which was released in 2004. With its modability and updates via Steam, it is a firm competitor on the gaming scene.

 



Some Gameplay Screenshots




These screenshots were shot solely by me as I played through the entire game.

 


 
 

 
 

 
 

 
 

 
 

 
 




Getting It To Run




You will need to fully update your system, including your graphics drivers. After your update, search for steam-launcher from your PCLinuxOS package manager. Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab if you wish and search for Portal. Click on and download the demo. If you have updated your system, including graphics drivers, you should be good to go.




http://store.steampowered.com/app/400/
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A Year of the Linux Desktop
 
 



by Stuart Jarvis

Reprinted from the KDE Blog




Around a year ago, a school in the southeast of England, Westcliff High School for Girls Academy (WHSG), began switching its student-facing computers to Linux, with KDE providing the desktop software. The school's Network Manager, Malcolm Moore, contacted us at the time. Now, a year on, he got in touch again to let us know how he and the students find life in a world without Windows.

 


 



A room full of Linux at WHSG (image by WHSG)
 



Stu: Hi Malcolm, thanks for agreeing to the interview. Could you tell us a bit about the school and your role there?




Malcolm: Westcliff High School for Girls Academy is a selective Grammar School with a Sixth Form of about three hundred and forty students. It was founded in 1920 as a co-educational school in Victoria Avenue, Southend, and moved to its present site in 1931. Since then the school has grown to its present size of around 1095 girls.




The IT Support department consists of three staff: myself, Paul Antonelli and Jenny Lidbury. My role is that of Network Manager. The IT Support department covers provisioning and support of all IT-related equipment within the school. This includes 200 teacher machines, 400+ student machines, 33 IMacs, 100+ laptops and a few Android tablets. We also support all the multimedia devices such as projectors, interactive whiteboards and TVs, etc.




Stu: Whose idea was it to switch computers over to Linux? What were the reasons for doing so?




Malcolm: We have used Linux as the OS for our Email server, VLE (Virtual Learning Environment) and web site for a while since I had used it before at my previous position in the financial industry. It was my idea to move the students' PCs to Linux as it was becoming increasingly obvious that with the size, cost and complexity of IT increasing seemingly exponentially, ultimately something had to give and professional pride would not let it be the quality of the systems we support. We tested a small set-up of sixty machines and got feedback from the students, adjusted it a bit and then tried again and so on. Once we had gone through this loop a number of times with Red Hat/Fedora and SUSE/openSUSE set-ups and we were satisfied, I put my proposal to the Senior Leadership Team.




The motivation was initially both cost and philosophical, in that, even in an outstanding school, funds are always going to be limited (politicians don't seem to get the saying 'If you think education is expensive, try ignorance'). The cost of using Windows is high but not always obvious, Windows carries a lot of baggage that bumps the cost up considerably over a Linux environment. The philosophical angle was probably the philosophy of pragmatism. We wanted to offer the best IT systems and education possible with the funds available. Money spent on essentially promoting Microsoft Windows and Office to students can be better spent on old-fashioned things like teachers and actual education. Subsequently and fortuitously, the UK government threw out the old ICT syllabus, which was based largely on teaching students how to use Microsoft Office, and told schools to go for a more computer studies-based syllabus, which meant that we were in a position to hit the ground running so to speak.




Stu: Was there any resistance to the idea and how was this overcome?




Malcolm: Surprisingly, very little. The Senior Leadership Team grilled me in two long meetings which was fun! Once you actually take a step back from the misconception that computers = Windows and actually seriously think about it, the pros clearly outweigh the cons. The world is changing very quickly. There is a survey that reports in 2000, 97% of computing devices had Windows installed, but now with tablets and phones, etc., Windows is only on 20% of computing devices, and in the world of big iron, Linux reigns supreme. We specialize in science and engineering and want our students to go on to do great things like start the next Google or collapse the universe at CERN. In those environments, they will certainly need to know Linux.




Stu: What choices did you make for the software and why? Was any new hardware needed?




Malcolm: We started out with the basic theory that the students had to like the interface, so 'pretty is a feature' was required for the workstations. For IT staff, stability is practically everything for the servers. Whilst I know there are many people who have favorite distributions, I only really know the RPM-based ones. If we had more resources, we could have looked at more, but we only tried Red Hat/Fedora and SUSE/openSUSE combinations. In the end, the SUSE/openSUSE won because of their KDE software support. Firstly, we did not want the change to be too much for students to handle and KDE's Plasma can be made to look very familiar. Secondly, during our testing, we encouraged students to try both KDE Plasma and GNOME. Plasma was by far the winner in terms of user acceptance. [The final software choice was openSUSE 12.2 and Plasma Desktop 4.10 - Ed].

 


 



One of WHSG's desktops (image by WHSG) 



As far as the workstations go, no new hardware was required. One of our main reasons to go to Linux was that it runs well on older hardware. The usual merry-go-round of replacing 400 student machines every 3 or 4 years is a horrendous cost. Many schools just simply can't afford that in these days of austerity. With the performance we have now, I intend to run these machines until they fall to bits! I would suggest to anyone however that they make sure they have a good network before embarking on this (see below for specific advice).




Stu: How did the switch-over go? Were there technical problems and how were they overcome?




Malcolm: The switch-over was done during the summer holiday of 2012. At that point we encountered no significant technical issues, although that isn't to say we didn't have any later!




Stu: Was there any software missing compared to the old systems?




Malcolm: We currently have students running Linux and staff running Windows 7. If there were a SIMS (Schools Information Management System) client for Linux, converting the whole school could easily have been considered. As it stands, that could have easily been an overreach. Nothing is missing as far as educational software for Linux, but we have retained a couple of Windows applications which we run under WINE so that students with work in progress can move slowly to alternative applications. One thing that is interesting is the use of the Raspberry Pi and the suchlike in schools. The Pi team stated that one advantage of using the Pi is that students can experiment without destroying the school or family PCs. With Linux, students can experiment now. Our ICT department is already teaching programming to students from year 7 [around age 11 - Ed.], and in our environment, the worst thing they can do is crash their own account. Even if they completely destroy their area, it can be restored in minutes and 
will not affect the next person using the machine.




Stu: Did you contact KDE or openSUSE for assistance? If so, how was the response?




Malcolm: I have frequently contacted both KDE and openSUSE through the forums and bugzilla sites; both were exceedingly helpful. openSUSE forums can be a bit hostile at times when others think the questions are poorly worded or not well thought out. This, happily, is not the case in KDE forums where everyone has been very polite and helpful. In openSUSE's defense, some of the questions I posted were not done well. However, as I said before, there are only three of us and sometimes RTFM isn't an option. There just aren't enough hours in the day. If I can post something and get an answer even if it seems dumb to others, it is a great help. If we had to learn everything about Linux, this project would never have happened, we would still be RTFM! Despite being called an idiot occasionally, we got good working answers to all our questions, so I can thoroughly recommend the forums even if it is necessary to be a bit thick-skinned at times.




Stu: What do the students, parents and staff think of the change?




Malcolm: Younger students accept it as normal. Older students can be a little less flexible. There are still a few that are of the view that I can get rid of Microsoft Word when I can pry it from them. Staff are the same (although it is surprisingly not age-related). Some are OK and some hate it. Having said that, an equal number hate Windows 7 and nobody liked Windows 8. I think the basic problem is that Windows XP is a victim of its own success. It works fairly well from a user point of view, it's been around practically forever, and people don't like change, even some students, oddly. Once we decided to go ahead, a special newsletter was sent out to all parents. We probably had less than half a dozen who disagreed, maintaining that learning Office was a more useful skill. Whilst I accept their views, I would argue that an 11 year old student starting with us in September 2014 will probably not reach the job market until 2024 or there about. What will Office 2024 look like? Your guess is as good as 
mine, but good basic skills and a logical and analytical way of dealing with computers will be good for a lifetime.




Stu: One year on, what worked and what didn't? What would you do differently or advise another school to do differently?




Malcolm: It would have been nice to say it all worked perfectly, but it didn't. The first half term was terrible. The primary problem was system speed and particularly logging into KDE Plasma. Our tests only had 60 or so machines in use as it was difficult to round up enough students at lunchtime and after school to really thrash the system. Plus while we were testing, we were still having to maintain the 400 student Windows XP machines. The bottom line is that Linux will run well on an old tin box, but if you have LDAP authentication and NFS home directories—as you certainly will have in a school or business environment, you must have a gigabit network. It will run with 100Mb, but it will be an unpleasant experience as we discovered to our cost. To that end, we had to replace about eight switches to bring our whole network up to gigabit everywhere (OK, it was planned to happen anyway, but I would have rather done it at my leisure!). Additionally some things in KDE software do not lend themselves well to 
having NFS home directories, although I know it has been addressed to some extent in later versions. We now have several scripts that we run on our servers that force some KDE options to take the load of our network Once we had worked all this out and fixed it over the next half term holiday things quieted down a lot thankfully.




Stu: How could KDE make such a switch easier?




Malcolm: Documentation! You can configure KDE in every way imaginable using the GUI, but admins need to set up defaults for all users. The openSUSE defaults are OK for home or stand-alone users, but they need a bit of adjustment in a school. In the end we did it by taking a basic machine, making a change and then going through the dot files to see what had been affected (this and bothering Ben Cooksley in the KDE forums). It was hard work! The problem here—and I'm not sure there is an easy answer—is that with Linux, and now to some extent with Windows, the technology moves so fast that documentation is out of date before it's printed or even written in some cases.




Stu: Which applications (KDE or otherwise) have been particularly impressive? In which areas are applications lacking?




Malcolm: With the exception of about half a dozen students who are using GNOME, everybody loves the fact that now they can configure their desktops and applications. Most admins lock down Windows as it is fairly easy for people, particularly students, to butcher Windows.We have taken the view that we want to get back to a PC being a personal computer, so students can configure it any way they like as it gives a sense of ownership of their desktop. We have restrictions on configuring a machine inappropriately or in a way that is detrimental to work. Students generally get one desktop reset before we will 'have words'. Allowing this is a novel idea in schools. In the beginning, some of the desktops were configured to destruction! Now that the novelty has worn off the desktops are more sane, and we haven't had to reset an account back to a more tasteful blue in months. In this respect, it is a great success as students are now taking responsibility for their work environment and how they achieve tasks 
rather than be told, "Here is a generic Windows and Office. Use that."




Stu: Any other comments or observations on the experience?




Malcolm: Has it given me sleepless nights, yes. Has it nearly driven me insane, yes. Would I do it again... in an instant!




Stu: Thank you very much - and best of luck in the future!




The example of Westcliff High School for Girls Academy gives us plenty to think about. Linux, with KDE software, can clearly work in such an environment, but there are still challenges in deployment and getting used to a new system. Malcolm's experiences underline the importance of the KDE forums in welcoming and supporting new users to bring free software to ever larger audiences.




Reprinted under Creative Commons Attribution 3.0 Unported License.
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Xfce Power User Tips and Tweaks, File Utilities (Part 3)
 
 



by Paul Arnote (parnote)




This month, we'll finish up our look at some Xfce file utilities tweaks. Last month, we featured the second part of the series, and the first part of the file utilities articles in the July, 2013 issue of The PCLinuxOS Magazine.




Most of this month's file utilities center around working with ISO files. This includes utilities to check, compute and compare md5sum files.

 



Convert Directory To ISO




Let's allow our imaginations to run for a moment. Maybe you've just returned from a vacation of a lifetime, and you want to share your pictures with family and friends. Maybe you are getting ready to reinstall, and you need to backup certain files in your /home directory. Or maybe you have a really large collection of wallpaper files you want to share with your computer buddies. Whatever the case, this Thunar Custom Action is for you.

 


 
 
 


Entergenisoimage -r -J -o %f.iso %F | yad --progress --title="ISO Creation" --progress-text="Please wait ... File(s) being processed." --percentage=40 --auto-close --auto-kill
 in the command line. (After all the articles in this series, you should already know the rest of the steps for creating a Thunar Custom Action.) Under the "Appearance Conditions" tab, leave the File Pattern set to the default value of *, and place a checkmark in front of Directories only.

 


 



You can select one directory, or multiple directories. When you select "Convert Directory To ISO" from Thunar's right-click context menu, your selected directory/directories will be converted into an ISO file, ready to be burned to optical media. In the event that you selected multiple directories to be included in your ISO, the ISO file will be named after the first directory selected. However, all of the directories selected will appear within the ISO file.




If you are seeking to fit files on a CD or DVD, you can select the directories, and then select "Properties" from the right-click context menu. Pay attention to the reported total file size. If your target medium is a CD, make sure the total file size is less than 700 MB. If your target medium is a DVD, make sure the total file size is less than 4.3 GB. In both cases, I'd recommend reducing those figures by about 3-5%. For whatever reason (byte alignment?), the ISO file will be slightly larger than the reported total file sizes of the directories by themselves. If nothing else, it'll give you a little "wiggle room," and help insure that your ISO file will fit onto the target optical medium.

 



Burn ISO To CD




Once you download your favorite PCLinuxOS Live CD or DVD, you will probably want to burn it to the appropriate optical medium. Who knows? You may even want to burn the ISO file we created in the previous Thunar Custom Action to optical medium. With this Thunar Custom Action, you can get busy burning your CD or DVD with two simple clicks of the mouse.

 


 



Enter /usr/bin/xfburn -i %f in the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.iso;*.ISO, and place a checkmark in front of "Other Files."

 


 



When you right click on an ISO file and select "Burn ISO To CD" from Thunar's right-click context menu, xfburn (Xfce's CD/DVD burner) will open, ready to burn the file to your selected optical medium.




As an exercise, you can also perform something similar by creating a data disc compilation. Create a new Thunar Custom Action, with the command /usr/bin/xfburn -d %F (or you can use %N if you prefer). Under the "Appearance Conditions" tab, leave the file pattern set to the default value of *, and place a checkmark in front of every file type. Just select the multiple files you want to include on your data disc, then select your new Thunar Custom Action from Thunar's right-click context menu. Xfburn will open, prepped to create a data disc compilation, and automatically import all of your selected files.




You can also do the same thing, but for creating an audio disc compilation. For an audio disc, your command will be 
/usr/bin/xfburn -a %N (or you can use %F, if you prefer). Under the "Appearance Conditions" tab, leave the file pattern set to the default value of *, and place a checkmark in front of "Sound Files." Just select the files you want to include on your audio disc, then select your new Thunar Custom Action from Thunar's right-click context menu. Xfburn will open, prepped to create an audio disc compilation, and automatically import all of your selected audio files.

 



Convert IMG File To ISO




Sometimes you might find a CD image file online, but it's stored in the *.img format. Fortunately, Linux has the tools to convert a *.img file to a *.iso file -- which we can work with. This Thunar Custom Action is for those files.

 


 



Enter ccd2iso %f `basename %f .img`.iso on the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, enter *.img as the file pattern, and place a checkmark in front of "Other Files." Notice that this will only match files with a file extension of "img" in all lowercase letters. If you download a file that has the file extension in all uppercase letters, rename the file to use all lowercase letters in the file extension before running this. To execute this Thunar Custom Action, right click on the *.img file, then select "Convert IMG File To ISO" from Thunar's right-click context menu. Once you've converted the *.img file to an ISO file, you can use the previous Thunar Custom Action to burn the new ISO file to the appropriate optical medium.

 



Mount ISO




OK ... it's time for another show of hands. How many of you had an ISO file lying around and wanted to see the files it contains? Well, this next Thunar Custom Action will help resolve your curiosity.

 


 
 
 



Entergksu 'mkdir -p /mnt/%n' && gksu 'mount -o loop -t iso9660 %f /mnt/%n' && thunar '/mnt/%n'
 on the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.iso;*.ISO, and place a checkmark in front of "Other Files."

 


 



Now, whenever you want to take a peek inside an ISO file, simply right click on it and select "Mount ISO" from Thunar's right-click context menu. You will be asked to provide the root password -- twice -- and then the contents of the ISO file will be displayed in a new Thunar window. You can view those files just as you would any other file on your system. You can even copy them to your /home directory, if you choose.

 



Unmount ISO




Want to know something about that ISO file that you just mounted? This Thunar Custom Action allows you to unmount that ISO file, and remove all traces of it ever having been opened.

 


 
 
 


Entergksu 'umount -d /mnt/%n' && sleep 2 && gksu 'rm -f -r /mnt/%n'
 on the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, enter *.iso;*.ISO as the file pattern, and place a checkmark in front of "Other Files."




To unmount the previously mounted ISO file, you will need to back to the original ISO file in the first Thunar window and right click on the original ISO file. Select "Unmount ISO" from Thunar's right-click context menu. You will be prompted for the root password -- twice -- and the ISO file will be unmounted, and then all traces of the folder in the /mnt directory will be removed after a two second pause (to allow time for the ISO file to be properly unmounted).

 



Compute md5sum Checksum




When you are downloading or preparing to use an ISO file, one thing you should be doing is checking the integrity of the ISO file by checking the md5sum checksum. This Thunar Custom Action provides you one method of checking the integrity of the ISO file.

 


 
 
 


Enterzenity --info --title="Check md5sum for %n" --text="$(md5sum %n)" | zenity --progress --percentage="50" --auto-kill --auto-close --title="Checksum utility" --text="Calculating md5sum for %n"
 into the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.iso;*.ISO, and place a checkmark in front of "Other Files."

 


 
 

 



When you select an ISO file, then select "Compute md5sum Checksum" from Thunar's right-click context menu, you will first get a Zenity static progress bar while the md5sum checksum is being computed. This will be followed by a second Zenity dialog box that displays the md5sum checksum.




While it's true enough that md5sum checksums can be used with any file, their use is most common with ISO files. You can modify this Thunar Custom Action easily enough to produce a md5sum checksum for any file on your system. Under the "Appearance Conditions" tab, simply change the file pattern back to the default value of *, and place a checkmark in front of every file type (except Directories ... I can't think of any reason to check the md5sum checksum of a directory).

 



Create md5sum Checksum




This Thunar Custom Action differs from the previous one in that it actually creates an md5sum checksum file, instead of just displaying it in a Zenity information dialog box.

 


 
 
 


Entermd5sum %n > %n.md5sum | zenity --progress --percentage="50" --auto-kill --auto-close --title="Checksum utility" --text="Creating md5sum for %n"
 in the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.iso;*.ISO, and place a checkmark in front of "Other Files." Like I mentioned when I talked about the previous Thunar Custom Action, you can expand the creation of md5sum checksums to all file types, if you want, by following the same directions I provided previously.

 



Check md5sum




This Thunar Custom Action is probably the most useful of all of the ones that work with md5sum checksums. It will compare your existing md5sum checksum to insure that it matches that generated from the original file.

 


 
 
 


Enterzenity --info --title="Check md5 for %n" --text="$(md5sum -c %f)" | zenity --progress --percentage="50" --auto-kill --auto-close --title="Checksum utility" --text="Checking md5sum for %n"
 into the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.md5sum, and place a checkmark in front of "Text Files" and "Other Files."

 


 
 

 
 

 



When you right-click on a *.md5sum file and select "Check md5sum" from Thunar's context menu, you will first see a static Zenity progress bar. If the md5sum file is correct for the associated file, you'll get a Zenity information dialog box that tells you that the md5sum file checks out OK. If the md5sum file is incorrect or doesn't match up with the associated file, you'll receive a Zenity information dialog box that tells you that the md5sum file has failed the check.

 



Install RPM




I save this one for last. WARNING: Remember that installing RPMs from outside the official PCLinuxOS repository may render your installation as unsupportable! As such, you are advised to NOT install outside RPMs. Proceed at your own risk! If you do install outside RPMs, you may not receive support via official PCLinuxOS support channels (such as the PCLinuxOS forum or the #PCLinuxOS-Support IRC channel).




Now, with that out of the way, there may be times when you need to install an RPM. Hopefully, it's an "official" PCLinuxOS RPM. At this point, it's imperative to remind you that PCLinuxOS RPMs are created especially for PCLinuxOS, and their format may not be the same as RPMs for other distros. Thus, don't assume that a Fedora RPM, or an OpenSUSE RPM, or a Mandriva RPM, or a Mageia RPM will work under PCLinuxOS. Most likely, none of the above will work with PCLinuxOS -- except a PCLinuxOS RPM. There are many reasons why they won't work, and this topic is much more than we need to go into here.

 


 
 
 


Entergksu -l 'rpm -Uvh %f' > /home/your-user-name-here/tmp/rpm.txt' | zenity --progress --percentage="50" --auto-kill --auto-close --title="Install RPM" --text="Installing selected RPM file..." && zenity --text-info --title="Install RPM" --filename="/home/your-user-name-here/tmp/rpm.txt" --width=800 --height=250 && sleep 10 && rm -f /home/your-user-name-here/tmp/rpm.txt
 in the command line of the Edit Action dialog box. Under the "Appearance Conditions" tab, set the file pattern to *.rpm;*.RPM, and place a checkmark in front of "Other Files" for the file type.


Let me explain what's going on here. First, we ask for the root password, and when supplied, the command to install the RPM is called. The output from the rpm command is written out to a temporary file (rpm.txt) in your /home/username/tmp directory. A static Zenity progress bar dialog box is displayed, to provide some visual feedback to let you know that "something" is happening. Once the rpm command has finished, the progress bar dialog box disappears, and a Zenity text-info dialog box is displayed, filled with the output from the rpm command. We issue a "sleep 10" command to allow time for the temporary file to be displayed, and we then delete that temporary file.




You will need to change the command above to reflect your username on your computer. We cannot use ~/tmp (as you might think) because the information is written out to the root user's /tmp directory. As such, we have no file viewing or deletion rights, as a "normal" user, in the /root/tmp directory. By specifying the exact location of the temporary file, and locating it in your /home/username/tmp directory, we have full access to that file, both to display it and to dispose of it when we're done with it.

 



Summary




That wraps up the file utilities. I'm sure that you might be able to come up with or think of some other possibilities. If you come up with a Thunar Custom Action for a file utility, I'd love to hear about it. I can't possibly think of them all. We all come from different backgrounds, and as such, we all have different needs. Feel free to let me know via email, or send me a PM in the PCLinuxOS forum.




Next month, I'll wrap up the Xfce Power User Tips, Tricks & Tweaks article series by taking a look at some miscellaneous tips. Some of them are ones that I either left out of previous discussions, or ones that I "discovered" after publication of the article to which they would have belonged. I'm also working on a special surprise for the final article in this series, so stay tuned!
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Testimonial: Making the Transition
 
 



by Dave Fitzgerald (NGIB)




Like most folks, I used Windows for many years and DOS before that. I never really cared for that company's marketing strategy -- pay us a lot for updated versions and buy new hardware when we tell you to -- but they satisfied my needs for the most part. I've been experimenting with Linux distros since about 2006, but there was always a few things that kept me from making the leap to Linux a permanent situation. Maybe a particular program wasn't available or I had strange hardware that didn't run right - y'all know the drill. In the past year or so I have begun the search for the Windows replacement yet again and I think I'm nearing the end of the journey.




Key to the search is finding something my wife can use, without her changing anything in the way she uses a computer. Generally, she hates technology, and she hates change even more. When Gmail changed their inbox strategy last month, I heard a stream of profanity from the kitchen, directed at me, for changing her inbox. I had to explain to her that Google made the change because they wanted to make her life easier. She then switched the focus of her profanity from me to Google. For my wife, things just need to work without intervention on her part. Learning to edit a config file or doing anything other than being a user will never happen. I set up her computer(s), keep them running, and do my best to insulate her from the change that always happens.

 


 



To make the change for her, I've searched for a desktop environment that allows me to setup a configuration for her that closely matches the Windows environment she has used for years. The ability to place launchers in the spots she's used to seeing them, and controlling what appears in the menus is very important. My dear spouse only wants to see things she uses, and does not want to sift through huge menus to find the program she wants. I'm like her in a lot of ways in that I like simplicity, and really dislike it when an OS tries to think for me or starts to look like a Saturday morning cartoon. I have never been a fan of KDE, I really dislike Unity, and while I kind of like LXDE, it does take some config file editing to make it work the way I want it to. The solution for me has been Mate.




I can create a Mate desktop that looks almost exactly like her Windows desktop, and make the panel look almost exactly like her Windows status bar. The same launchers in the same place, and a menu that I can customize so she only sees what's necessary for her to see. It's taken me over a year to wean her from Internet Explorer, and she now uses Firefox and Chrome. It's a blessing that these browsers look and feel the same under Linux. Skype used to be a problem under Linux (this was usually the program that kept me/her on Windows), but it appears to work well now.




One of the blessings of Linux is that I control when updates happen, and what gets updated. I have received many phone calls at work where my wife is explaining to me that an evil box has popped up on her screen asking her to accept the update and reboot.  Antivirus programs are notorious for that, and not needing one is one of the biggest benefits of Linux.




As far as which Mate distro, I'll be honest and say I've tried most of them. Each has it's foibles, but I've chosen PCLOS as it is the best for what I need from an operating system. I really like the way some programs are installed directly (LibreOffice and Calibre come to mind), so you get the latest software but inherent stability in the repos. The ability to set up a system and make a live USB is absolutely great in my opinion. I do all the setup and refinement work on one computer, and then I'm able to make an installable USB image of that system which makes it easy to setup multiple computers with the same tweaked OS. The only downside I see to PCLOS is that it does not support Debian packages, which would make it near perfect in my humble opinion. The folks running the repos do a great job though, so this is a small thing generally.




The last area of selecting a distro is certainly the most important -- what kind of support is available. There are some distros that expect (require?) you delve into the inner workings of config files, bash scripts, and have 6 terminals open at one time. Merely asking a question can subject you to a tirade of just how ignorant you are and how you're too stupid to use the distro anyway. While I haven't really run into any issues I couldn't solve on my own, I've read a lot of the questions asked on the PCLOS forum, and I'm really impressed by the answers I've seen. Even the questions involving arcane and unique hardware are answered patiently and without the "buy a new computer" tone you hear at other sites. This is really important, since switching from the familiar to the unfamiliar is a daunting task, and it's great to know that real help is available. 




Yes folks, there is an alternative to Windows, and you do not have to be a programmer to use it.
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Password Security Revisited
 
 



by Paul Arnote (parnote)




By now, each one of us has heard it a million times and then some more. Every time we turn around, someone else is talking about password security. The recent hacking of the Ubuntu website in July drove the issue back to the foreground of computer security conversations.




On July 21, 2013, a hacker who calls himself Sputn1k_, gained privileged access to the Ubuntu forum servers. Not only did he deface the site, he also gained access to an estimated 1.82 million email addresses and passwords belonging to Ubuntu forum members. While user passwords were encrypted, that encryption turned out to be pretty weak. At fault was the VBulletin forum software that Ubuntu used to power its forums. The VBulletin software uses a "salted md5sum" checksum to encrypt passwords. Reports abound regarding how weak this encryption schema is. You can read the Ubuntu forum hack postmortem article that provides details about how the forum was hacked. The Ubuntu forum was closed for a week or more, as a result of the hacking of the Ubuntu forum.




Let's add into the mix the recent uproar about the U.S. National Security Agency (NSA) spying on computer and telephone communications against average, non-threatening citizens all around the world. No one is exempt from the NSA's intrusions into our everyday lives. Discussions about the security of your data, personal information and accounts has reached a fever-pitch, thanks to these two very high profile situations.

 


 



As such, it's timely to reexamine what makes a good password, and password strategies to avoid. We'll also take a look at some good suggestions in creating a secure password. First, let's look at some password strategies to avoid.

 



What NOT To Do




 	 Don't use numbers easily associated with YOU. Avoid using your zip code, your telephone number, your address, your birthday, or (heaven forbid) your Social Security number. Anyone attempting to hack your information will definitely give these a try.



 	 Don't use proper nouns. Using the name of your girlfriend, wife, pets, place of employment, etc. are just as frivolous as using numbers that are easily associated with you. If your attacking hacker knows anything about you, he/she/they will give these fairly well-known facts about you a try in an effort to crack your passwords.



 	 Don't base your passwords on your username. Sometimes, when signing up for an account, you might be tempted to base your password on your username. DON'T DO IT! It's too easy to guess, and very easy with a dictionary or brute force attack.



 	 Don't use real words or phrases that you can find in a dictionary. Everything popular is on a wordlist ... a wordlist that is in the hands of hackers. You can bet your last cent that they will try words from that list. You might be tempted because of something that you are really interested in, and it makes it really easy for you to remember, but resist the temptation. A password built this way won't stand up to a hacker utilizing a dictionary attack based on a common word list.



 	 Avoid ANYTHING on this list. Here's a list of the 25 most common passwords from 2012. Trust me ... some of these may have you rolling on the floor with laughter.




          1. password 

          2. 123456 

          3. 12345678 

          4. abc123 

          5. qwerty 

          6. monkey 

          7. letmein 

          8. dragon 

          9. 111111 

          10. baseball 

          11. iloveyou 

          12. trustno1 

          13. 1234567 

          14. sunshine 

          15. master 

          16. 123123 

          17. welcome 

          18. shadow 

          19. ashley 

          20. football 

          21. jesus 

          22. michael 

          23. ninja 

          24. mustang 

          25. password1 


 	 Don't reuse passwords between sites. We've all done it. We latch onto a "favorite" password that we somehow develop an emotional bond with, or one that's incredibly easy for us to remember. If your account's password is hacked on one site (like the Ubuntu Forum site), every other account that you also "protect" with that same password is also at risk.


 


 



What TO Do




 	 Use a phrase to "seed" your password, using a method that only YOU know. This isn't too hard to do. Memorize the first sentence/paragraph of your favorite novel, or your favorite line from your favorite movie. Then, make your password the first letter of each word in that phrase. You could make it even more challenging, try using the second letter from each word in your "seed."



 	 Use a mixture of lowercase letters, uppercase letters, numbers, symbols and punctuation marks. The more you can mix it up, the better. However, try to avoid "predictable" patterns, such as putting a period after every letter. Some systems don't allow anything but letters and numbers to be used in passwords. While it may limit the effectiveness of your password, you can still achieve a very high level of security with just letters and numbers. Add symbols and punctuation marks into that mix on the systems where they allow them to be used in a password, and you dramatically increase security exponentially. Also, be aware that some systems now allow spaces in passwords.



 	 Periodically change your passwords. How often should you change your passwords? There's a lot of debate about it, but if you're the least bit interested in protecting your data and your accounts, you should be changing your passwords minimally once a year. If you're determined to protect your identity, data and accounts, you can change your passwords every 60, 90 or 120 days.



 	 Use a unique password for each separate account. Every account you have should have its own, unique password. We've all been guilty of reusing passwords. But when ... not if ... one of your favorite sites (like the Ubuntu Forum site) gets hacked, that puts all of your other accounts that also used the same password and user information at risk. Take a look at one suggestion in the "How To Make A Secure Password" section of this article, a little farther on.



 	 Size DOES matter. Bigger is better. An eight character password ... let's use Som3TiM3 as an example ... would take a hacker about 15 hours to break, using an average desktop PC. While it has a mixture of uppercase letters, lowercase letters and numbers, it isn't nearly as secure as Som3TiM3syOuSnffeR. The latter, at 18 characters long, would take that same hacker, using an average desktop PC, one quadrillion years to crack the password. Yes, that's 1,000,000,000,000,000 years. That seems like a pretty good level of security to me! Also, notice how I used a "3" for the first two occurrences of the letter "e" and used an "n" for the letter "u" (after all, a "u" turned over is a "n"). Consider that I achieved this high level of password security all without using a single symbol or punctuation mark.



 	 Test your password. So how did I find out how secure the passwords in the previous tip were? So how do you find out how secure YOUR password(s) is/are? While you could just leave it to chance and delude yourself into thinking that your passwords are secure, there are websites where you can actually test out how secure your passwords are. I was surprised to find out that some of my passwords that I thought were secure could be hacked in only hours. Just perform an internet search for "check password strength." 





One such site is called How Secure Is My Password. Another is at Gibson Research Corporation, on their "How Big Is Your Haystack?" site. Simply enter the password and you will get immediate feedback about how secure it is. If you're hesitant to enter your actual password, fearful that a site like this might attempt to steal your password, make up a different password using the same schema. Then be sure to apply that schema to your final password.

 


 
 



How To Make A Secure Password




Secure passwords aren't all that difficult to come up with. We've already discussed a few methods: use a passphrase to "seed" your password, mixing in numbers, letters of varying cases, symbols and punctuation marks, avoiding using a word you can find in a dictionary. We even talked about using openssl to generate secure passwords in the September 2009 issue of The PCLinuxOS Magazine.




Find a method that works for you. For example, you can use a base phrase, and add elements to it to increase security. For example, let's use "computer" as our base phrase. Let's add some numbers to that. So now, "29computer61" becomes our password. But let's not stop there. Now let's add some punctuation and symbols. So now, "29@Computer!61<>" becomes our password.




Let's use the first website to test how secure our passwords are. If we were to use only our base phrase, our password would require virtually no effort to crack, and would be cracked almost instantly. With our second iteration of the password, made by adding some numbers, the security of the password increases dramatically. It would take a hacker with an average desktop PC 37 years to crack the password. With the addition of some punctuation and symbols, along with one uppercase letter, our third iteration of the password is the most secure. Only 16 characters in length, it would take a hacker armed with an average desktop PC 412 trillion ... 412,000,000,000,000 ... years to crack that password.




Another method to employ is to incorporate the name of the site into your password, which will help to make it unique to that particular site. As an example, let's set up a password for the PCLinuOS forum. First, start with your passphrase seed (thiNgy). Second, add some numbers to it (54thiNgy28). Third, add some part of the site name (54thiNgy28PCLX). Using just four of the consonants from the PCLinuxOS site name, we add PCLX. If we were making a password for Google, we would add GGL to the password. Yahoo would become YH. Ubuntu could BNT, or if you use the vowels, it could be UBU. I think you should be able to get the idea here. Fourth, add some symbols and punctuation (54@thiNgy28PC?LX). Using this method, you are able to create a unique password for each and every site that you visit.




So ... how secure is that? Let's take a look at how secure each of those passwords are by taking a look at how long it would take for a hacker using an average desktop PC to crack.




 
  	thiNgy
54thiNgy28
54thiNgy28PCLX
54@thiNgy28PC?LX

  	4 seconds
6 years
98 million years
412 trillion years
  
 





If you want to explore some other ways to create unique passwords, I highly recommend Luigi Montanez's Protect Yourself With Password Recipes article. That's what I've proposed above ... a secret recipe for creating your passwords that ONLY you know.

 



Summary




Almost everything we do in these times has some kind of online influence. You can order a pizza online for home delivery. You can shop for clothing without ever getting up off of your sofa. You can pay your bills and manage your bank accounts online.




If you think this is password security overkill, you won't think that for long if your personal information, accounts, and private data are hacked. Who knows what the hacker(s) will do with that information. They could do nothing with it, if all they were after was to see if they could hack a system. Or, they could literally destroy your life, your financial security, and your reputation. Fortunately, Sputn1k_ has subsequently decided to pass on attempting to decrypt the user passwords from the Ubuntu forum, despite its weak encryption. Not all hackers would pass on such an opportunity.




The username and password method of protecting your accounts is a bit long in the tooth. It doesn't scale well to the internet, where we have a plethora of accounts, each with a different content provider. In a way, it fuels peoples' desire to be lazy and find shortcuts ... like using the same password over and over for many sites. Security experts are in complete agreement that something better needs to be developed. You can read this article for a general discussion about what needs to be done and what's being done.




In today's age, information is king. We live in a much different time than even when I was born in 1960. We face information overload every single day. We are interconnected in ways no one could imagine even 20 years ago. Creating a secure password is your front line defense. Make your passwords complex, containing the tips provided here, and you just may make the hackers' jobs too difficult to mount an assault on your data. Instead, they'll just move on to "lower hanging fruit," hacking the passwords of users who haven't bothered to create a secure password. Creating secure passwords to protect YOUR information data and reputation ... at least until something better comes along, is more vital now than it ever has been.
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How to Set Up VPNBook on PCLinuxOS
 
 



by Texstar




VPNBook is a Free VPN (Virtual Private Network) server is designed with the latest technologies and most advanced cryptographic techniques to keep you safe on the internet from prying eyes and hackers. The VPN securely routes all your internet traffic through an encrypted tunnel to bypass government censorship, defeat corporate surveillance and monitoring by your ISP. VPNBook strives to keep the internet a safe and free place by providing free and secure PPTP and OpenVPN service access for everyone.

 


 



This is how I got it running on PCLinuxOS!



1. Install openvpn from the Synaptic Package Manager.



2. Open your webbrowser and go to http://www.vpnbook.com/freevpn.



3. Download one of their certificate bundles. I just wanted something to browse the web with, so I selected the US OpenVPN Certificate Bundle.



4. I open my file manager and extracted the zip file (VPNBook.com-OpenVPN-US1.zip) in my Downloads folder.



5. I copied the vpnbook-us1-tcp80.ovpn to my /home/texstar folder.



6. I made note of the username and password on the http://www.vpnbook.com/freevpn download page. The current name and password as of this writing is Username: vpnbook Password: 7haHufr7



7. I opened a terminal session and su to root. (You may not have to do this if you have your network connection setup from the PCLinuxOS Control Center to allow users to control the connection).



8. I typed openvpn --config vpnbook-us1-tcp80.ovpn, which started the service. I entered the username from step 6 and pressed enter. It then asked for password, which I typed from step 6. (Please note you will need to go to the vpnbook website often to get updated name and password as it changes from time to time).



9. I closed Firefox and started it again. I was now browsing the internet in private. 



10. Press Ctrl+C to close the service and return to normal mode. Please note that you will need to close and start your web browser again after stopping vpnbook.
 


 



An additional tip comes from Just17. For those who wish to start the VPN without any manual input of the username and password, create a file with two entries, one per line. The first line gets the user name and the second line gets the password. Put nothing else in the file. Call the file login.




Then use the following command to launch the VPNBook service (as root of course), and providing the correct <path to> that points to the appropriate files.



openvpn --config/<path to>/vpnbook-euro2-tcp80.ovpn --auth-user-pass/<path to>/login




That should make it easy to incorporate in a permanent start up, if required. However, you will need to go to the VPNBook website periodically to obtain the updated username and password, and then update the login file when they change. For example, the password (but not the username) changed on August 20, just as the layout process started for this issue of The PCLinuxOS Magazine.

 



The Editor's Trial Run




I tried the instructions as listed, and they work exceptionally well. I did a few things differently, though. For starters, I downloaded the Euro2 OpenVPN Certificate Bundle, just for fun to see if it worked from my location. Even though I'm dab smack in the middle of the U.S., it still created a VPN client on the VPNBook servers in Romania.




The second thing I did differently is I called my username and password file vpn-login. I stored that file in my /home/parnote-t42 directory. Then, I started the OpenVPN client with this command (as the root user):



openvpn --config vpnbook-euro2-tcp80.ovpn --auth-user-pass vpn-login &




The login to the VPN server in Romania was then automatic, and the "&" at the end of the command caused the entire process to run in the background. This released my terminal session for other uses. To quit the openvpn session, simply type pkill openvpn as the root user in a terminal session.




As soon as my VPN connection was made and authenticated, my net_applet icon in my notification area changed from the "bars" that simulate signal strength with my typical wireless connection, to the green checkmark on a black circle icon. Hovering my mouse over that icon showed that, indeed, I was now cruising the internet under a different IP address.




A restart of your web browser is probably best, but the second time I connected to VPNBook, I purposefully did not restart Firefox -- just to see what would happen. Google complained that someone from Romania was attempting to log into my account. Truthfully, Google complained the first time, but I missed the notification. So I had to confirm that the login attempt was made by me. I guess that's just proof positive that Google tracks your login information based on your IP address.




When I brought up the Google search engine, I was not automatically logged in (as is the usual case when I bring it up while on my "regular" internet connection). Furthermore, I was staring at the Google.ro home page, and not the typical Google home page we see here in the U.S. I was also logged out of and back into Xchat IRC, due to the IP address change.




Overall, the free VPN from VPNBook works very well. There are security concerns (in the form of the logs that they say "they don't keep" that keep showing up as evidence in trials against members of Anonymous -- see my companion article for more information), but it does work and it seems to do exactly what it purports to do.
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OpenVPN: Other VPN Services
 
 



by Paul Arnote (parnote)




Previously in this issue of The PCLinuxOS Magazine (and in the PCLinuxOS forum), Texstar wrote about using OpenVPN (installable from Synaptic) with VPNBook, a free VPN (Virtual Private Network). However, since Texstar's original post in the forum, some information has surfaced that may cause users to view the free VPN service suspiciously.

 



User Beware!




VPNBook has been accused by Anonymous hacktivists of turning over log files relating to the activities of Anonymous members to the authorities. Here is the complete post (text and graphic) from Anonymous's Google+ stream on January 20, 2013. The graphic has been edited to blur out items that may be offensive to some readers. If you want to view the unedited graphic, then visit the previous link to the actual Google+ post.




Logs from vpnbook.com and voxility.com have appeared in the court discoveries and indictments of some Anons facing prosecution for their involvement in #Anonymous activities. Do not use these services. Be advised and please share.

 


 



If you have no "illegal" or "suspicious" activities to hide, then VPNBook may serve your needs just fine. But if the Anonymous charges are true, the log files of your specific online activity are freely available to the authorities "for the asking." Such actions defeat the major purpose of connecting to the internet by a VPN.




Here's how the Pete Zaborszky put it on his website, Best VPN, in his article on this situation:




While we have no idea whether this accusation is true, the VPN service run by Romanian Infrastructure firm Voxility does appear to offer a suspiciously feature-full package given that it charges nothing, while boasting of high speeds, OpenVPN and PPTP protocols with 128-bit or 256-bit AES encryption, no bandwidth limits, no restrictions on what the service can be used for (i.e. P2P), and that logs are discarded every week (and that only the IP address and time the connection is made are logged, not users' activities).




VPNBook says the service is supported through advertising, but it does seem surprising that they can offer two servers in Europe, and server each in the UK and US using OpenVPN encryption on this model.




Of course, if the accusation is not true (or it doesn't worry you), then all these features on offer for free may make VPNBook worth checking out...




VPNBook does advertise that they do not maintain logs of your activity while connected to the internet via their VPN (visit their website via the link in the Anonymous quote above to see for yourself). However, Zaborszky presents a very valid point in his response. How can such a full featured package that boasts high speeds, OpenVPN and PPTP protocols, 128-bit and 256-bit AES, no bandwidth limits, no usage restrictions, and logs that are discarded every week ... be offered for free, via no less than four dedicated servers, using an advertising supported service?

 



You Get What You Pay For




That old adage "you get what you pay for" seems to really hold true when it comes to selecting a Virtual Private Network provider. Fortunately, the Best VPN website offers not only reviews of VPNs, but it also provides lists of the best OpenVPN compatible VPN providers.




Almost all of the alternative VPNs are fee-based services. The prices tend to range from around $4 per month (U.S. currency), to around $20 per month. Some VPN providers offer the ability to pay for up to a year at a time, usually with significant savings over paying for the service on a monthly pay-as-you-go basis. For example, HideMyAss.com, one of the top ranked VPN providers, was running a special when I was writing this article. Under that "special," the monthly pay-as-you-go service cost $9.99, but paying for an entire year cost $59.99. By paying for an entire year of service up front, that brings the cost down to $4.99 per month (amortized out over the entire year).

 



Why Use A Virtual Private Network?




If you're still not convinced of the value of using a VPN, let's take a look at the benefits.




Hardly anyone on the face of this planet hasn't heard of the NSA's snooping, not only on foreign nationals, but also on American citizens. Many of us have used open, insecure public WiFi hotspots. Most of us are becoming increasingly aware and wary of the mining of our personal data on the internet. Use of a VPN remedies those problems.




Increase your online security. Using a VPN encrypts your internet traffic, and prevents eavesdroppers and hackers from easily intercepting your online data. This is especially useful for those times when you are using an open, free, public WiFi hotspot.




Works with all internet applications. Unlike a web proxy, which only protects content fed through your web browser, a VPN remains active for all of your internet applications. This means that your Pidgin conversations, IRC chats, and every other online activity is protected by tunnelling your internet connection.




Virtually reside in another country. By using a VPN, you can change your online identity to make it appear that you reside in another country. This makes it so that users can view content that might typically be restricted to users of a certain country, such as some iBBC content, some YouTube content, programs on Hulu or NetFlix, etc. The application of this feature of a VPN is often enough to justify its use, especially if you live in an area of the world where there are strict internet restrictions.




Anonymous internet identity. When you connect to a VPN, your online identity (typically your specific IP address) will be masked behind one of the anonymous IP addresses of the VPN server or provider.




Government level security. Most VPNs use the same encryption standards that are used and enjoyed by governments all around the world.




Bypass censorship. By using a VPN, you can circumvent censorship, regardless if it's site specific (like at the office), from an internet provider (traffic shaping), or blocked sites (at the office or by a government).





Summary




So, although the VPNBook provider specified by Texstar in his article may raise some suspicions, there are other VPN providers who are a bit more "secure" with your data and usage logs (if they even keep logs at all ... some providers don't even keep them). Of course, you will have to pay for that security. It all boils down to how secure do you want your data and your browsing habits to be? How much do you want to avoid others being able to scrutinize your internet activities?
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Testimonial: A Quiet, Long Time Fan





by blerton




I'm a long time fan of PCLinuxOS - I now have more than 70 machines running it. They contribute to distributed computing projects - Einstein@Home, Milkyway@Home and LHC@Home. The first two (for some time now) have applications that run on GPUs - both nVidia and AMD/ATI.




In particular, I have 12 machines with HD4850 GPUs that have crunched for MW since early 2009 using Windows XP and the Catalyst 12.1 drivers, which were the last ones with the OpenCL support needed for the MW GPU tasks. I have long treasured the hope that one day I could work out how to run the same tasks under PCLinuxOS. I worked out how to do that about two weeks ago, and have so far converted 9 of the 12 without problem.




I've been a very infrequent lurker on these forums for several years and by pure chance, I stumbled across this quote: "When you get a Synaptic fglrx update notice you will want to install either the fglrx-legacy packages or the fglrx-current packages depending on your video card." It caught my attention. I had seen the Synaptic update notice about fglrx-current and fglrx-legacy some time ago and that had prompted me to go hunting on the AMD website for more information. From that, I knew I needed the legacy driver, and I read that to get OpenCL support for the GPU, I needed to install the catalyst driver first and then the AMD APP SDK. The only problem was that whilst fglrx-legacy was in the repo, there was no SDK that I could find.








While I was contemplating what to do, one of the 12 WinXP machines had a disk failure. I decided to install the latest KDE-minime, set up the fglrx-legacy driver, and test things out.  No problem doing that, but trying to run a MW task gave an immediate failure. So I downloaded the SDK (Version 2.7) from the AMD website, unpacked it and ran the install script that was included. The messages looked all very promising, so after a quick reboot, I tried another task. I was very pleased to see immediate success. I also found the aticonfig command, and have used it to enable overdrive, and then set core and memory frequencies to my liking. In the nine machines I've converted so far, the GPU crunch times are comparable to, or even slightly better than, those achieved under WinXP.




The biggest difference is in the crunch times of Einstein tasks running on the CPUs. Ten of the 12 machines have dual core CPUs -- mainly e6300 Wolfdales -- and the two CPU tasks running alongside the GPU task are significantly slowed (>30% longer to crunch) under WinXP, compared to a similar machines with no GPU. Now, under PCLinuxOS, there is no (or very little) such slowdown so this is another big win. Needless to say, I'm quite delighted with the outcome of a hard disk failure.




I just wanted to thank all those responsible for PCLinuxOS. I started using it in 2007, and it has always been a very good fit with the way I like to do things. I've sampled other distros, but have never found anything else that can even get close enough to stand a chance of luring me away! I've been contemplating purchasing a couple of HD7870s, so I'll probably do that now that I know that the OpenCL runtime can be had by installing the SDK from AMD. Is there any likelihood that OpenCL support might be included in the repo sometime soon? I've been using the CUDA support I found there for nVidia cards for some time now. I actually have around 20 machines, mainly with GTX650s, all running PCLinuxOS of course!














 [bookmark: page12] 

Gramps Genealogy Program





by Dwight Dover



       
Gramps is a terrific program for tracking your ancestors. If you are saying to yourself "who cares?", then you must be under the age of 50. I know that was also how I felt. Then, my father-in-law brought me a pile of documents and photos, many of which dated from the early 1900's, and wanted them digitized and placed on a computer disk for distribution to relatives. His concern was the loss of all that data, when he was gone. After trying a spreadsheet program, I began looking for a better way. Gramps Genealogy package was found in our Synaptic Package Manager!








Yes, it is easy to use. That was one concern of mine. I simply began by entering my name (Add a New Person) with the information I knew, like date of birth, town where I was born, and a photo or two. I added my wife (Relationships-Add a Partner) and then began entering parents (Add a New Set of Parents).








You may find lots of information about your ancestors on the internet simply by searching for a name and possible birth date. Ancestry.com is an excellent source to find information about your family. Remember, if it is on the internet it must be correct!! NOT! Thousands of people may be found on Ancestry.com, along with family trees. I believe the author's intention is good, but, sometimes incorrect information will be copied. It is your job to try and sort the facts.








Gramps will print many reports from your database. Graphs, kinship, places, and dates are just a few of the many reports available. The one I like is the Narrated Web Site. This beauty will print all your provided information into a nice format for viewing. A family tree will be provided at the bottom of an individual's page. This tree can show up to 5 generations and clicking on anyone in the tree will reveal up to 5 more generations. This Narrated Web Site may be uploaded to your server or you may burn the data to a CD and pass it to your relatives.








Discovering your ancestors is addicting. I have discovered relatives who fought in the Civil War and others who participated in the Revolutionary War. With some effort, you will be able to discover this much and more! Want to learn more? Go to http://gramps-project.org/. 




Good Hunting!
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PCLinuxOS Puzzled Partitions





Download Puzzle Solutions Here




Download Puzzle Solutions Here



PCLinuxOS Crossword Puzzle: September 2013

                              Foods



Download Puzzle Solutions Here



Food Word Find


Download Puzzle Solutions Here
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ms_meme's Nook: Texstar From Texas
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Want to run Windows in VirtualBox? for Free?





by Paul Arnote (parnote)



Most Linux users are former Microsoft Windows users, and we can divide them into one of three camps. In the first camp, there are Linux users who have cut the cord with Microsoft and use Linux exclusively for all of their computing needs. The second camp contains others who aren't able to free themselves from Microsoft's grip, relying on a dual boot situation that allows them to run certain beloved Windows programs that they just can't seem to abandon. The third camp is filled with those who use Microsoft Windows in a virtual machine (e.g., VirtualBox) to run those occasional Windows programs for which there are no viable alternatives, such as U.S. income tax software installable from a CD or Windows download.  (PCLinuxOS users can still use online versions of tax software such as TurboTax Online, TaxAct, and H&R Block Online.  However, they will get a message saying that their browser is not supported.  Simply ignore the warning.)








Believe it or not, that "evil empire" of Microsoft has just made it incredibly easy to run Microsoft Windows in a virtual machine ... for free! Say what?! That's right, and this is no joke. The Internet Explorer team, in an effort to foster maximum compatibility of websites across as many versions of Internet Explorer as possible, has released VirtualBox copies of Windows XP, Windows Vista, Windows 7 and Windows 8. Intended for web developers, these fully functional copies of Windows are available to anyone and everyone.




Direct your web browser here: http://www.modern.ie/en-us/virtualization-tools#downloads. You will see the webpage displayed above.








First, select the operating system platform you are running. The VirtualBox images are available for Windows, Mac and Linux users.








Currently, only VirtualBox images ("Virtualization Platform") are available for Linux. If you are using Windows as the host, there are "virtualization platform" images for Microsoft's own Hyper-V, VirtualBox, and VMWare. If you are using a Mac as host, "virtualization platform" images are available for VMWare, VirtualBox and Parallels.








Once you select VirtualBox as your "virtualization platform," you will be given the choice of downloading the following combinations:




 	 Windows XP with IE6


 	 Windows XP with IE8


 	 Windows Vista with IE7


 	 Windows 7 with IE8


 	 Windows 7 with IE9


 	 Windows 7 with IE10


 	 Windows 8 with IE10


 	 Windows 8.1 Preview with IE11





Only the Windows XP images are available as a single file download. All of the other virtual machine images are available as multipart, self-extracting RAR files. To download the Windows XP images, you can click on the file link on the web page. You can also enter wget https://az412801.vo.msecnd.net/vhd/IEKitV1_Final/VirtualBox/Linux/IE8_XP/IE8.WinXP.For.LinuxVirtualBox.sfx in a terminal window, for example, to download the Windows XP image with IE8.




To download the multipart image files, you can download each one separately by clicking on each file in your web browser, and saving each one to your hard drive. Alternatively, you can also use the terminal to download the parts of the self-extracting RAR archive. First, change to the directory where you want to save the files, then issue the wget command, supplying the URL of the associated *.txt file for the multipart file you want to download. For example, to download Windows 7 with IE 11, you would enter the following:



wget -i https://az412801.vo.msecnd.net/vhd/IEKitV1_Final/VirtualBox/Linux/ IE11_Win7/IE11.Win7.For.LinuxVirtualBox.txt




This command will download all of the files in the multipart self-extracting RAR file. Just be aware that most of these virtual machine images are rather LARGE files. For example, the download of Windows 7 with IE 11 is about a 4.3 GB download.








Once all of your files have downloaded, open a terminal (if you don't have it open already), change to the directory where you saved the files, and make the *.sfx file executable, by entering chmod +x IE11.Win7.For.LinuxVirtualBox.part1.sfx. Next, enter ./IE11.Win7.For.LinuxVirtualBox.part1.sfx on the command line, and let the command run until finished. The multipart RAR file will be "assembled" into a *.ova file. In the example above, the IE11 - Win7.ova file is 4.3 GB when reassembled.




At this point, if you haven't already installed VirtualBox (via the Get Oracle VM VirtualBox installer in PCLinuxOS), now would be a good time to do so. Once installed, launch VirtualBox. From the VirtualBox "File" menu, select "Import Appliance..."








Select the "Open Appliance" button in the upper half of the dialog box. Select the Windows *.ova file that you downloaded and extracted, followed by the "Next" button.








Under the "Appliance Settings" dialog box, you can view all of the settings for the virtual machine. You can change any of the settings by double-clicking your mouse on the setting, and making your changes. Once you're satisfied with your settings, select the "Import" button.








While your new virtual machine file is being imported, you will be shown a dialog box similar to the one above. Because I'm installing this on one of my slower computers with a single core processor, it's reporting quite a long time to finish. Don't worry. The actual time until completion isn't as long as is reported. On my single processor IBM Thinkpad T42, it took about 10 minutes or so to load up the virtual machine file.














As you can see from the images, the copy of Windows 7 that I downloaded is the Enterprise edition, complete with Service Pack 1. The copies of Windows XP that are available are all reported to be complete with Windows XP Service Pack 3.




Here are the recommended memory requirements for the Windows virtual machines:




 
  	Windows XP images:
Windows Vista images:
Windows 7 images:
Windows 8 images:
  

  	256   -   512MB
512   -  1024MB
1024  -  2048MB
1024  -  2048MB
  
 


    


You may be able to get away with less memory. I did, when I installed my copy of Windows 7 on my IBM Thinkpad T42, which is maxed out at 2 GB of RAM. I have it installed and set to use only 512 MB of RAM. It runs just as well with that limited amount of RAM in my VirtualBox installation as the much newer computers at the hospital where I work that run Windows 7, installed on bare metal.





Caveats




Of course, these caveats are excluding the normal, typical precautionary things that are associated with running Windows: viruses, malware, spyware, etc. Installing and running antivirus, anti-malware and anti-spyware software is a choice you will have to make for yourself, within your new Windows virtual machine.




Here are the "restrictions" on the use of these Windows virtual machines:




 	 These copies of Windows virtual machines are intended only as "evaluation" copies, and are not supposed to be used for any "production system."



 	 You are free to use these free Windows virtual machines for "testing purposes," but not "commercial purposes."



 	 You can use these Windows virtual machines free for only 90 days after being installed. After 90 days, the virtual machine will stop running, and any data stored on that virtual machine will become inaccessible (more on this in a bit).



 	 The Windows 8.1 Preview expires on January 15, 2014, and cannot be accessed after that date.



 	 The login name for all of the Windows virtual machines is IEUser, and Passw0rd! is the password for the Vista, Windows 7 and Windows 8 virtual machines.





As for "overcoming" the 90 day time limit, this recommendation comes straight out of Microsoft's PDF file containing detailed requirements and installation instructions:




 
  
   	
"It is also highly recommended that you implement a rollback strategy for any virtual   machines that you download. This could be as simple as holding onto the original archive that you downloaded, or you could take advantage of your virtualization platform's snapshotting capability so that you can start over with a fresh VM at any time and not have to worry about the guest operating system running out of trial time."
    
   

  





So, to remove any ambiguities in the above statement, make a snapshot of your Windows virtual machine right after you install it and any programs you are planning to run. If you are getting close to the 90 day time limit, secure your files (copy them over to your host PCLinuxOS system by setting up some shared folders). Then, first clone your snapshot, then work off of the snapshot copy. This way, you will always have a pristine copy of your Windows virtual machine stored as a snapshot.





Summary




Even though Microsoft has a well-deserved reputation as "the evil empire" in the computing world, for those PCLinuxOS users who are interested in having a real, legal, fully-functioning copy of Windows to run in VirtualBox, this offer couldn't possibly be any better.




Sure, there are other alternatives to running Windows programs under Linux, such as using tools like Wine, PlayOnLinux and Crossover. But some Windows programs simply won't run under those environments, and even if they do, some suffer from severe performance issues. Using a "reverse engineered" set of the Windows APIs, you are quite likely to experience some compatibility issues with different programs. Your milage may vary, depending on what you are expecting, wanting or needing from such an environment. Running Windows in a VirtualBox is, by far, the best solution that offers the best compatibility and stability.




While it's true that Windows XP is nearing "end of life" status, for many users, Windows XP is sufficient for their uses. At some time in the future, support among software publishers will wane to being almost non-existent. I would encourage anyone who wants to download a copy of Windows XP to also take the extra time to download a copy of Windows 7 -- even if you don't plan on using it any time soon. That way, you add some insurance for that eventual day when Windows XP will no longer serve the purposes you need, because of lack of support from not only Microsoft, but also software vendors.























 [bookmark: page16] 

LibreOffice Tips & Tricks, Part 3





by Meemaw




In this third installment of our series, we will look at LibreOffice Calc, and ways to spice up your spreadsheet, protect your hard work and make some of it a bit easier.





Autoformat Tables 




Some of you design your spreadsheets to be used in meetings or somewhere that people can see your handiwork. It makes sense that you don't want all your spreadsheets drab and colorless, and you also want to make certain fields stand out, like your headings and section names. You can do this by changing the background color of those cells. You can go into your table and highlight part of a row and change it, then highlight another partial row and change that, but try this first. Highlight the table you are working with, then click Format > Autoformat. A window will pop up with several choices to select, and as you go through the list, each design is displayed on your spreadsheet/table, showing you what it will look like. One of those may work for you.








Protect Your Document




Just like document protection in your Writer documents, you can password protect your spreadsheets as well. Just go to Tools > Protect Document > Sheet or Document. There you can establish password and parameters for your protection.





Vary Your Charts




You can always do the standard bar graph, but sometimes change to a 3D Pie Chart. Highlight the items you want in your chart, then Insert > Chart. You will get a window where you can designate your design, and a sample will appear on your spreadsheet.








Change Status Bar Values 




While you are working with your sheet, click on a column of numbers, then look at the status bar across the bottom of your window. Mine says “Sum=8,482.18” which is the sum of the numbers in the column.








That's great for some things, but what if you want an average of the numbers? or have loads of them and want to know the largest or smallest one? Right-click your status bar there and choose what value you want to see. My chart is an expense chart. What if I want the average of all expenses? Right-click.... choose Average... and there it is. Very useful!








Navigator 




We looked at the Navigator in a text document and found it useful. Yes, you can use the Navigator in a spreadsheet as well. If your spreadsheet is large, or has several sheets, the Navigator should help you get around in it pretty quickly. The Navigator lists sheet names, links, graphics, conditional formatting, values and a few other items.





Functions




Suppose you have an expense sheet that you just constructed. How do you total your expenses? You can highlight the column, look at your status bar and see what the sum of your numbers is. You can also add it up on the calculator and type it in. However, this is a spreadsheet and those kinds of functions are built-in. One way is to click on Insert -> Functions. A window will pop up asking what kind of function you want to insert. This is good when you are constructing your sheet but haven't entered all your values yet. The Function window contains all the functions programmed into Calc. You can choose the one you need and enter the cells you want to use.








I want the sum of all the expenses for January. As you can see, I only entered the cells that actually have numbers in them. While this works many times, it is a little tedious. When I'm doing a budget and only want to add certain lines together, I can use this method. If the column is a line of cells that can all be added, there is a faster way.




Starting with the cell where you want your sum, click and highlight the whole column clear up to the first cell that could be used. Now, click the sum symbol to the left of your input line, and your formula will appear. Notice that instead of each filled cell being listed, you have a range of cells to be included in that sum. I actually use both methods on my budget.








You can copy that design onto a different sheet (for February maybe?) and do the same thing. The good thing is that if different cells in that range are filled, you will still get a sum at the bottom. You want to check to make sure you have the correct range in your input line for that cell. My boss asks me to make a report of bills that need to be paid every month. I use the same spreadsheet every month and have the column set up to add the amounts together. It's always correct, and all I have to do is change the names, descriptions and amounts every month.





Change the Function of the Enter Key 




It's possible to change the function of the enter key. By default, when the Enter key is pressed, the cell below the current working cell is selected. However, if you need to keep moving right frequently, you can set the function of the enter key to move to the immediate right side cell, each time the Enter key is pressed. This is located in Tools > Options > LibreOffice Calc > General. 





Auto-Fill




I am wanting to make a schedule for employees who work for me. Rather than using one of the calendar templates, I am going to list the days of the month in a spreadsheet and list the employees who work on each day. Numbering is really tedious, though so I will do it differently. After I set up my title and headings, I will enter a 1 in my ‘Date' column. Then, moving my mouse to the bottom right corner of that cell until my mouse pointer changes to  a plus sign, I click and drag down my column until I have highlighted 31 spaces (I'm doing October's schedule). When I lift my finger off the mouse, the column will be numbered. Quick and neat! I did have to leave that cell and then click back into it before I got the plus sign. Also, if you don't get enough cells filled to suit your needs, click on the last cell filled and repeat the process, and auto-fill will continue on with the number sequence. If your sequence is to be different, like 3, 6, 9, and so on, just put the first two or three numbers in, highlight 
all the cells you just filled and do the same. Auto-fill will finish it for you. It works with dates, too!








Freeze Columns 


If your spreadsheet contains a lot of columns, certain columns can be frozen on the screen while the remaining columns move freely. For example, if your first two columns are Name and Company, these two columns can be frozen on the left hand side of the chart while viewing the data in the other columns. Highlight the column to the right of the ones you want to freeze, then click on Window > Freeze. Everything to the left of the column chosen will be in the ‘freeze zone'. Freezing them will enable you to be able to tell which Name & Company each piece of your data belongs to. In the example below, I chose one cell, to the right of the series of dates in my employee schedule, and below the headings. This keeps the dates and the headings visible as I scroll through the sheet.








Text Formatting 




If you enter a number like 00643 in a cell, it automatically becomes 643 due to the default formatting. You can always right click and format the cell as text, but you can also you could just enter '00643 and the cell is automatically formatted as text and the value is entered as it is. This can also be applied to text, dates, etc. However, you cannot apply formulas to such cells. 





Auto-Filter 




One of the spreadsheets I use often includes mostly names and addresses. There are hundreds of entries on this particular sheet. I may want to check the names of the members who live in ‘Colorado'. I can highlight the ‘State' column and apply the auto-filter (Data > Filter > Auto-Filter) to this particular column. A drop box appears on the top of the column. It will have the states contained in this column, and I can select ‘Colorado' from the drop box to see only the rows with a value of ‘Colorado' in the ‘State' column. Cool, huh? 








If you decide you don't want or need this filter any longer, you can go back to the same menu location and uncheck Auto-Filter.




Amazingly enough, many of the items in this article were things I didn't know, and have just learned from my research! Many of them have made my work much easier. Next month we will look at LibreOffice Impress to see how we can speed up the creation of a presentation.
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Photorec: Recover Your Deleted Files





by daiashi








Have you ever been in a hurry, and did not back up your files properly? Then you hit that empty recycle bin button one too many times? I did just that! I deleted all the pics I used for work in one fell swoop! I just sat there, thinking, "Oh yea, I have a server full of free software that the hard working folks at PCLinuxOS have packaged to get me out of such a situation." So I fired up Synaptic, hit the reload button and searched for "file recovery". Lo and behold, my eyes focused on photorec. If this happens to you, give it a try. I did, and got all my pics back and then some.




Now for the inner workings. After you download it, you will want to start it in a terminal. Issue the su command and your password to give you root status, then type photorec. Choose the drive you want to search, hit enter and then choose the partition holding the files. Once you get to the partition screen you will see at the bottom. 




 >[Search]  [Options ]  [File Opt]  [  Quit  ].




If you go the search route, be forewarned. You can fill up a hard drive in no time. In my case, I used my camera phone that was plugged in as my search directory. In short order they were all there. So if you are in that situation give this little jewel a try. It saved me, so maybe it can save you too.





Now a little about the person responsible for Photorec.




Cgsecurity is a site created by Christophe Grenier. He started the project in 1998 and is still the main developer. He is also responsible for the packaging of TestDisk and PhotoRec for DOS, Windows, Linux, MacOS X and Fedora's distribution. http://www.cgsecurity.org/





A few screenshots
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Inkscape: ms_meme & the Holiday Tree





by Meemaw




A couple of years ago, ms_meme and I entered a holiday wallpaper contest on the Linux Graphics Users Forum. We both used Inkscape to design our wallpapers, and ms_meme won first prize!








When I asked her how she did that beautiful wallpaper, she said that she had gotten the idea from a Christmas card she'd seen, and opened up Inkscape to see what she could do.




The first thing you should do is the tree. Opening Inkscape, choose your "paper" size (for a wallpaper, I choose 1600 x 1200). Selecting the Bezier tool, make a zig-zag set of lines, clicking every time you want your line to change direction. 







When you get something you like, right-click to end the drawing process. Your line should be green when you have clicked to change direction, and red until you click the next time, and black (or whatever your stroke color is) when it's finished. Then click on the Nodes tool (at the left side under the cursor arrow). Now your selected tree should be red again, with a node at each corner.








We're going to mess with these a bit. If you click on the node (the little square on the end), you can lengthen and shorten the lines and move them up and down, space them out, whatever you want. If you click on the red lines between the nodes, you can curve the lines a bit. You should move and curve until you get the nodes arranged the way you want your tree to look. I have clicked on the upper line just inside each node, and dragged out to make the curves. 








Click on your cursor tool every so often and see what your curve looks like, then go back and move your line and nodes until you have what you want. This would also be a good time to save your work in svg format. You can name it "Tree" or whatever.








When you are satisfied and your file is saved, select the tree you just created, and duplicate it (Edit > Duplicate or <CTRL> + D). When you duplicate an object, the new one is created in the exact same spot as the one you have. If you notice anything, you might notice that the colors of your object are deeper. The duplicate is selected, so grab it with your mouse and move it around a bit until you like how it looks. You can enlarge it a bit by grabbing the arrow on one of the corners or sides and pulling out. You can reverse it. You can even go back to the nodes tool and move it a little more.








When you are satisfied, use your cursor to select both objects. From outside them, click and drag a large rectangular area. The rectangle should disappear, and both of your curves should be selected. Click on Object > Group or click the Grouping tool in the toolbar above. You can also press <CTRL> + G. If you are satisfied, save your work.




The good thing about saving in the svg format is that it is all saved as data, so you can still go back and change things (even a font if you have text) after you have saved a drawing. Anything can be changed in the svg file. When you are finished, you should export your work in a different file type. I usually export to a png file, but there are many file extensions you can use. The exported file can't be changed, but you will still have the svg file in case you want to try something different.




You can move your tree to the side of your page while we do the decorations. Let's do the colored balls first. Click on your circle tool, hold down the <CTRL> button, and click & drag a circle. Remember, we held down the <CTRL> key to make our circle perfectly round. If you like ovals, then make them oval. Choose your fill color and, if you want to, choose a hairline gray stroke. They will be small enough that the stroke won't be visible. Duplicate the circle. On the duplicate, change your fill to white, and send it to the bottom. On your colored circle, change your fill to a round gradient.








We need to edit this a bit. In your Fill & Stroke window, click on Edit. You will get a new window where you can change your gradient around. Click on one of the gradients in the drop-down, and slide the indicators in the lower slider to the other end. Choose the other gradient and slide those to the other end as well, then close the window. In the left side tool bar, click on the gradient tool. You will see the gradient lines on your circle. Click on the one in the center and drag it up and to the left to change the highlight on your circle.








Select both circles and center them both ways. Next, draw a small rectangle at the top of the circles. It should have a grey fill and a dark grey or black stroke. This is the addition at the top where the hanger is attached. It needs to be behind the circles, and centered at the top. When you get them placed and are happy with your work, group them to make one decoration. You can duplicate it as well. In fact you should make a couple of duplicates and ungroup them long enough to change the fill color, unless you want them all the same color. Don't forget to regroup them.








We can also make stars to help our tree shine. I have put a dark blue background on my page so I can see the stars. A blue rectangle the same size as your page will work. Make a couple of stars, one of them a six-point star and one of them an 8-point star, both with a spoke ratio of .1, filled with white and no stroke. Click on Filters > Shadows and Glows > Glow to make your star more "shimmery". I applied that filter twice on many of the stars.








You can manipulate your stars with the handles, rotating and stretching them out so they aren't all exactly alike. You can also go back and create stars with more points if you wish. Make lots of duplicates, and arrange them on your tree as you desire. You can even make a larger star to go on top.











As a bit of accent, select your blue background, and change the color to a radial gradient. The default is blue in the center extending to transparent on the outside, but it might look better if you edited your gradient so the blue is outside and the transparent is in the center. It doesn't even have to be totally transparent. Click on your gradient tool and change the handles as below to make your highlight a little less circular. You can make it as big or small as you want.








Save your work, then export your picture. The good thing about Inkscape is that you can always go back and change it if you decide you want it a little different.








As you can see, my tree is designed basically the same as ms_meme's but turned out differently (her decorations are all smaller, for one thing). Remember though, that it is your creation, not someone else's, so it is up to you to decide how it looks. I'm sure your design will be wonderful!
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Screenshot Showcase





Posted by Actarus    running KDE 




Posted by Agust     running e17 




Posted by Crow     running KDE 




Posted by daniel     running lxde 




Posted by ff103     running KDE 




Posted by jogurtmen     running KDE 




Posted by RobNJ     running e17 




Posted by scoundrel    running mate 




Posted by µT6     running KDE 




Posted by TerryH     running mate 
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Basic | Appearance Conditions

Name: Check mdSsum

Description: | Check mdssum

Command: | zenity -info it Checkmdsfur%n

[ Use Startup Notification

?

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file
%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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Basic | Appearance Conditions

Name: Create mdSsum Checksum

Description: | Create mdssum checksum file

Command: | mdssum %n > 9%n.mdssum | zenity --p

[ Use Startup Notification

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file
%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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Does your computer run slow?

Are you tired of all the "Blue Screens
of Death” computer crashes?

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Download your copy ioday! FREE!
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windowsXP-error.png
Setup Error,

Microsot Windows has encountered an
unrecoverable error. Please reboot and

install PCLinuxOS.
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TorrentFreak

The place where breaking news,
BitTorrent and copyright collide
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magazine-irc.jpg
Visit Us On IRC

« Launch your favorite IRC Chat Client sofware
(xchat, pidgin, kopete, etc)

« Go to freenode.net

« Type *Jjoin #pclosmag"
(without the quotes)
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Linux Man Pages






commandlinefu.jpg
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100% Free VPN Service

- PPTP and OpenVPN Protocols Supported
-Works on All Mobile Devices and Operating Systems.
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There Are No Stupid Questions

’ linuxfordummies.org

3
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- No Logging
-No Speed Limits

| - Unlimited Bandwidth
-No %Required





pclinuxos_search_index.jpg
Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

>

he PCLIniX0S magazine
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End of Line Report...

Family Group Report
Kinship Report...
Number of Ancestors Report...
Place Report...

Records Report...
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sudoku.jpg
SUDOKU RULES: There is only one valid solution to each Sudoku
puzzle. The only way the puzzle can be considered solved
correctly is when all 81 boxes contain numbers and the other
Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefiled for
you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 8 and no
two numbers in the same column of a Sudoku puzzle can be the
same. Each row must contain al of the numbers 1 through 9 and
N0 two numbers in the same row of a Sudoku puzzle can be the

same

Each block must contain allof the numbers 1 through 9 and no two
numbers in the same block of a Sudoku puzzle can be the same.
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[SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
ties with which to make as long of a word|
a5 you possibly can. Words are based on
the Engiish language. Non-Engiish
Ianguage words are NOT allowed.
2. Red letters are scored double poits.
(Green letters are scored tiple points.
3. Add up the score of a the letters that
you used. Unused letters are ot scored.
For red or green letters, apply the
multplier when tallying up your score.
Next. apply any additional scoring
multiplers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tles in a setto
make your word. You will not necessarily
be able to use all seven (7) of the letters
in your set to form a *legal” word.
5. In case you are having difficuity seeing
the point value on the letter tles, here is
lst of how they are scored

0 points: 2 biank tles

1point:E,A,1,0,N,R, T, L. S, U

2 points: D, G

3 points: B, C, M, P

4 points: F; H, V, W, Y

5 points: K

8 points: J, X

10 points: Q. Z
6. Optionally, a tme limit of 60 minutes
should apply to the game, averaging to
12 minutes per leteer ile set.
7. Have funt Its only a game!

Download Puzzle Solutions Here!
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ms_meme.jpg
1 oined the forum in August 2008,
At that time 1 did not know who
our hero Texstar was, but 1 did
Know 1 realy liked PCLInwx0S.
September of the same year there
was a ig flood in Houston, Texas.
1 remember many members were
very concerned about Texstar. We
were ail_waitng for the 2009
retease of PCLInXOS.

1 took the opportuniy o sing a
it song.

2009, 2010, 2011, 2022, 2083 anl
came.  Every release_brings
happiness and satistaction o
many users.

TE)&

O once upon a time in Houston Town
id Texstar at his ‘puter sat around
He fiddled at the keys with a magical touch
‘gonna make something they'l ke so much
Then it stared 1o rain and the wind did biov.
His r0of top went just where he didr't know
He grabbed a sausage and said oh well
161 can't compile then this 1l sell

Peons round the world heard that Tex got wet
Wirung their hands and started t fret
“They sat on their bums ith tongues hangin out
Then and there they started to shout
Oh whatwillwe do s anybody’s guess.

Oh what will we do vithout PCLOS
O what il we doto relieve this distress.
We need Tex to make progress

Now the elders of the forum stepped up 1o the plate

‘And said for the best you just gotta wait

id Tex and the Gang will be here soon

And what they've got will make you swoon
2009 will give you 50 much more
vl tll be radical jus ke before.
‘We're gonna have a party it wll be right here

wPs S0 stop that crying in your beer 566
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Windows-VM-IE3.png
Select Virtualization Platform

Select Virtualization Platform

VirtualBox for Linux
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Windows-VM-IE7-VB-Appliance-Settings.png
Import Virtual Applicance

Appliance settings

These are the virtual machines contained in the appliance and the
suggested settings of the imported VirtualBox machines. You can
change many of the properties shown by double-clicking on the
items and disable others using the check boxes below.

[Description Configuration
Virtual system 1
% Name IE11 - Win7
& Guest 0 Type B Windows 7
@ ceu 1
® R 512 M8
®ovo @
£ UsB Controller El

I~ Reinitialize the MAC address of all network cards

Restore Defaults| < Back cancel






Windows-VM-IE7-VB-Import.png
Import Virtual Applicance

Appliance to import

VirtualBox currently supports importing appliances saved in the

Open Virtualization Format (OVF). To continue, select the file to
import below.

Open applianc

Hide Description| = Eack cancel
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Starting Windows





Importing.png
& Importing Appliance ...: Importing appliance /home/parnote-t42/ISO/Win7-

Importing virtual disk image 'IE11 - Win7-disk1.vmdk' ... (2/2)

S 1% @

4" 2 hours, 40 minutes remaining
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Linux Training
Courses & Classes






photorec.png





mate-desktop.jpg
DOWNLOAD

. RS innO
Mate Desktop






pclinuxos-robot-full.jpg
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Radically Simple.

PCLirux0S

Available in the following desktops:
KDE LXDE Xfco
Gnome  Enlightenment e17.





A_Call_For_Articles.jpg
A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the.
PCLinux0S Magazine,
send an email to
pelinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles
specific to PCLinux0S.
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The PCLinux0S Magazine

Created with Scribus 1.4.1






donate-pclinuxos.jpg
Donate To PCLinuxOS

Community Supported.
No Billionaires/Millionaires.

No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
t0 make a monthly, recurring donation.
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Where *BSD & Linux Converge
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ConvertIMGtoISO1.png
Basic | Appearance Conditions

Name [convert IMG file to 150

Description: | Convert IMG disc file to 150 file

Command: | ccdaiso %f "basename %f img' iso

[ Use Startup Notification

&

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file

%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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Burn image

Image to burn

Burning device

MATSHITA DVD-RAM Uj-862 |~

Drive is empty
options
¥ Eject disk
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¥l Burnfree
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MountISO1.png
Basic | Appearance Conditions

Name Mount 150

Description: | Mount the selected ISO file

Command: | gksu ‘mkdir -p /mnt/%n’ && gksu ‘moun

[ Use Startup Notification

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file

%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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mag-want-to-help.jpg
Want To Help?

‘Would you like (o help with the PCLinux0S
Magazine? Opportunities abound. So get
involved:

You can write artcles, help edit articls, serve
as a "technical advisor” o insure arlcles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing is
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Created with
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tuxmachines.org
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1SO Creation

Please wait .. file(s) being processed
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CreateISO1.png
Basic | Appearance Conditions

Name onvert Directory To 150

Description: | Converts the selected directory to an ISO fl

Command: | genisoimage -r -] -joliet-long -0 %fiso (

[ Use Startup Notification

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file

%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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BurnISO1.png
Basic | Appearance Conditions

Name Bum 150 to €

Description: [Burn an IS0 file to a blank CD with Xfburn

Command: | jusr/bin/xfburn -i %f

[ Use Startup Notification

The following command parameters will be
substituted when launching the action

%1 the path to the first selected file

%F the paths to al selected files

% directory containing the file that is passed in %f
%D directories containing the files that are passed in °F
%n the first selected flename (vithout path)

%N the selected filenames (vithout paths)
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